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COPYRIGHT NOTICES

THE WORD processor Family of Products come with program disks and
a set of disks containing the text of the Bible. The contents of these
disks are copyrighted and it is illegal to duplicate them without
permission or to use the contents in any form for any commercial
purposes. However, because disks wear out with frequent use, it is
recommended that you copy each disk and use only the copy for daily
use. The original disks should be stored. Permission is granted to
duplicate the disks for backup purposes only.

If you are using the New International Version be aware that the text is
copyrighted 1973, 1978 by the International Bible Society. All rights
reserved under International Conventions. The text is not to be
reproduced in whole or in part without the prior written permission of the
International Bible Society, except for one backup diskette for the
personal use only of the end-use purchaser. No copies of the diskettes
may be bartered, traded or sold. For further information write:
Permissions International Bible Society, 144 Tices Lane, East
Brunswick, NJ 08816, United States of America. Permission is granted
for the free (no charge) distribution of printouts of the New International
Version text, so long as the following information appears on each page:
The Holy Bible, New International Version, Copyright 1973, 1978
International Bible Society

If you are using the Revised Standard Version be aware that the Bible
text is from the Revised Standard Version of the Bible, copyright 1946,
1952, 1971 by the Division of Christian Education of the National
Council of the Churches of Christ in the USA, and used by permission or
the Revised Standard Version Apocrypha, copyright 1957 by the
Division of Christian Education of the National Council of the Churches
of Christ in the USA, and used by permission.

If you are using the New King James Version be aware that the Bible
text is from the New King James Version of the Bible and not to be
reproduced in copies or otherwise by any means except as permitted in
writing by Thomas Nelson, Inc., Nelson Place at Elm Hill Pike,
Nashville, Tennessee, 37214-1000.




THE WORD processor

Family of Bible Study Products

THE WORD processor

THE WORD processor is a family of products. You may begin with the
VERSE SEARCH product and add the others at any time as your Bible
study grows. Each product you add integrates with the other products
you have already installed to provide the most comprehensive Bible
study aid available on computers.

VERSE SEARCH

A quick concordance program that finds any verse in the Bible instantly.
VERSE SEARCH includes the entire text of the Bible with programs for
searching the text for any English words or phrases and printing any
portion of the text. The Bible text is available in either the KJV, NIV,
NKJV or RSV translations. All additional products in THE WORD
processor family require VERSE SEARCH and expand upon its features.

LIBRARIAN

Librarian creates permanent cross reference indexes useful in personal
study of the scriptures. You can build a library of personal indexes that
store the results of each of your studies. Each of your lessons becomes a
permanent part of your Bible. You can refer back to previous studies at
any time. You can also merge indexes from separate studies to find the
combination of verses that deal with either or both subjects. An
invaluable aid in preserving each study. Librarian also includes a Lesson
Editor for writing the text of lessons or sermons and easily incorporating
scripture text.

VERSE TYPIST

A memory resident program that will insert scripture text into your word
processing program on demand just as if you had typed it in yourself.
An excellent tool for sermon or lesson preparation. For example, if you
were using any word processor to write a document, you could press a
key and automatically see the text of the verses you requested inserted
into the middle of your writing.

BIBLE DICTIONARY

A dictionary of words that have special meanings when used in scripture.
The Bible Dictionary gives historical background and usage explanations
that help you to understand the language of scripture.
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Family of Bible Study Products

TOPICS
A Topical Bible. A reference library of indexes to the Bible text for over
200 of the most prominent subjects in scripture.

PEOPLE
A reference library of indexes to the Bible text for over 140 of the
characters most prominently addressed in scripture.

CHAIN REFERENCE

This product ties together those verses in the Bible that form a common
thought. To better understand any verse, you can review a list of
associated verses that explain, expand or contrast one another. This
uses the Bible to explain the Bible. You will be able to create or modify
your own chain reference Bible.

PERSONAL COMMENTARY

This product allows each user to add personal commentary to any verse
in the Bible. It works similar to writing notes in the margin of your
printed Bible. But your notes are always there, even if you switch to
another Bible translation.

CHRONOLOGICAL BIBLE

A presentation of the Bible in chronological sequence. A chronological
Bar Chart of the Bible is displayed and you may select any point in time
to begin your reading. A time sequenced outline of the Bible is then
displayed beginning at the point you selected. All verses that deal with a
specific event or time period are displayed together.

GREEK ftransliterator

This product assigns Strong's reference numbers to the English words of
the New Testament and includes programs for searching for Greek words
to show their English translations or for English words to show their
Greek origins.

HEBREW transliterator

This product assigns Strong's reference numbers to the English words of
the Old Testament and includes programs for searching for Hebrew
words to show their English translations or for English words to show
their Hebrew origins.
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Chapter 1 Getting Started

1.1 Using this Manual

THE WORD processor is a family of products for personal study of the
Bible. You may begin with the VERSE SEARCH product and add the
others at any time as your Bible study grows. The chapters of this
manual contain directions for the VERSE SEARCH product. The
appendices describe each of the add-on products in THE WORD
processor family.

This manual is designed to help you get started and to provide detailed
information on how the family of products works. For those who learn
best by example, illustrations are included showing how to use each
command.

Chapter 1 of this manual explains how to get started. It includes a
detailed installation guide and a general description of
features that apply to all products in THE WORD
processor family.

Chapter 2 is a hands-on tutorial that steps you through a variety of
the features. It is recommended that you do this exercise
before reading the detailed instructions in other chapters.

Chapter 3 explains how to browse through the Bible displaying any
verse anywhere at any time.

Chapter 4 explains how to print any portion of the Bible text or copy
any portion of the Bible to a file for use with your word
Processor.

Chapter 5 tells how to use the VERSE SEARCH product to search
through the Bible for anything you want to find.

Chapter 6 describes the basic terms and concepts used by all products
in THE WORD processor family.

Chapter 7 tells how to customize for your computer.

Appendices contain detailed instructions for each of the add-on
products in THE WORD processor family.

Glossary defines terms that may be new to you.

Index is a cross reference of the key subjects in this manual.




1.2 What You Need

THE WORD processor family of products requires the following
resources:

A personal computer running the DOS operating system (3.0 or later).
At least 640K of memory

A monitor (monochrome or color).

A hard disk drive with 2 megabytes for each Bible translation.

A printer is optional, but beneficial.

A mouse is optional, but beneficial.

1.3 Installation

Each product you purchase from Bible Research Systems comes with an
installation program called INSTALL. Before using the product, you
should first run this INSTALL program to prepare working copies of the
product. Before you run the INSTALL program, make sure you have
NO MEMORY RESIDENT PROGRAMS IN MEMORY.

The INSTALL program on each product will ask you where you want
the product installed and tell you what disks will be needed. The VERSE
SEARCH product must be installed first. Each of the other products can
be installed at any time and will be integrated into the other products
already installed.

Step 1: Place in Drive A the disk for the product you want installed.

Step 2: Enter the command: A:INSTALL (press the ENTER key)

You will be asked to verify the destination where you want the new
product installed. The default will be on Drive C in the subdirectory
called \BIBLE\. The INSTALL program will ask you to insert each disk
required.

Installing Additional Translations

Each Translation disk contains the specific INSTALL program needed
for that translation.




1.4 How to Start

Step 1: Set the current directory where THE WORD processor products
are installed. For example, use the command:

CD \BIBLE (press the ENTER key)
Step 2: To start the program, enter the command:

TWPS (press the ENTER key)

A copyright message will be displayed. When you press the ENTER key
(or click the mouse on the Ok button) the Bible text will be displayed.

For a CGA Adaptor Card
If you have a CGA Color Adaptor Card with a monochrome screen, you
should add /M as a parameter on the execution command:

TWP5 M (press the ENTER key)

This instructs THE WORD processor to use only the monochrome
display. See the Palette command for setting the display best suited for
your monochrome screen.

1.5 How to Quit

The Exit command stops THE WORD processor.

Using the keyboard to stop:
Press the Alt key. (to activate the menu bar)
Press the Q key. (to select the Quit menu)
Press the X key. (to choose the Exit command)

Using the mouse to stop:
Select the Quit menu and choose the Exit command.




1.6 Help When You Need It

The Help function is available at all times to provide detailed
instructions on what to do now. You can get Help in two ways:

select the Help menu and choose the command, or
press the F1 shortcut key at any time.

The What to Do Now command displays detailed instructions that apply
to what you are currently doing. You would use this command any time
you need help in understanding what to do now. All the options
available to you will be described.

1.7 A Familiar Interface

THE WORD processor family of products uses the standard (SAA)
interface published by IBM. If you have used other programs that use
this standard, you already know how to use THE WORD processor.
What you see on the screen and how you give instructions are identical
to other programs that use this standard.

If this interface is new to you, this manual will help you get started.
There are some new terms and some new concepts that you will learn,
Once you are familiar with them, these terms and concepts can be used
on any product that uses the IBM standard interface. The chapter in this
manual called "Basic Skills" is designed for anyone who has not used the
IBM standard interface. You may want to read that chapter now before
getting into the detailed capabilities of THE WORD processor family of
products.

The top line on your screen is called a Menu Bar. It contains a list of
menus. Each menu contains a list of commands and works just like a
restaurant menu, you review the commands available and choose the one
you want, You can select a menu from the Menu Bar and choose a
command to carry out your desired action by using either the keyboard
or the mouse.




1.7.1 Using the Keyboard

All procedures in THE WORD processor can be performed with a
keyboard. This section explains the conventions used throughout this
manual in describing keyboard operations. A mouse can also be used if
available.

Key Names

Names of the keys appear in this document spelled out in capital letters
(for example: SPACEBAR, ENTER, PAGEUP). Your keyboard may use
abbreviations for these names or represent them a bit differently.

Key Chords

A plus sign (+) used between two keynames indicates that those keys
must be pressed simultaneously. For example, "ALT+S" means that you
should press the ALT key and hold it down while you press the S and
release it. You should then release the ALT key.

Key Sequences

A comma (,) used between two keynames indicates that those keys must
be pressed sequentially. For example, "ALT.F" means that you should
press the ALT key and release it, then press the F key and release it.

Direction Keys

The Direction keys are the four arrow keys on the keypad. The name of
the individual arrow key refers to the direction the arrow is pointing: the
UP key, the DOWN key, the LEFT key, and the RIGHT key.

Selecting a Menu and choosing a Command

To activate the Menu Bar, press the ALT key. To select a menu, use the
LEFT or RIGHT keys to move across the Menu Bar. To choose a
command, you use UP or DOWN. When the highlight is resting on the
command you want to choose, press the ENTER key. If you decide not
to select a menu nor to choose any command from the menu, press
ESCAPE.




1.7.2 Using the Mouse

THE WORD processor does not require a mouse. All operations can be
performed using the keyboard. However, if you have a mouse installed
on your computer, you may use it to move, expand or shrink windows,
to choose commands, to select data and to scroll window contents. A
mouse can be a beneficial tool in using THE WORD processor.

When you start THE WORD processor with your mouse installed, you
will see a small rectangular block displayed on your screen. This block,
called the "mouse pointer”, will have a different background color than
the other characters on your screen. When you move the mouse across a
flat surface, the mouse pointer will move on the screen in the same
direction as you move the mouse. If you run out of room for the mouse
on your surface, lift the mouse and put it down where you have more
room. With the mouse lifted, you can move the mouse without moving
the pointer.

THE WORD processor can be used with a single button or multiple
button mouse. If you have a mouse with more than one button, use the
leftmost button. The following terms refer to operations performed with
the mouse.

Point To move the mouse until the pointer rests on what you want to
point to.

Click To quickly press and release the mouse button.

Drag To press the mouse button and hold it down while moving the
mouse.

Double-click To click the mouse button twice in rapid succession.

Selecting a Menu and choosing a Command
You can use the mouse to select a menu and choose commands. Follow
this procedure.

1. Point the mouse to the desired menu name on the Menu Bar. Click
the mouse button. This selects the menu under the mouse pointer.

2. Point the mouse to the desired command in the menu. Click the
mouse button. This chooses the command under the mouse pointer.

To cancel menu selection using a mouse, simply move the mouse pointer
to a location outside the rectangle which contains the menu of commands
and click the mouse button. The menu will disappear and you will be
returned to where you were before you selected the menu.




1.8 Book Name Abbreviations

The following abbreviations are used to edit input and label output:

GEN - GENESIS NAH - NAHUM

EXO - EXODUS HAB - HABAKKUK
LEV - LEVITICUS ZEP - 7EPHANIAH
NUM - NUMBERS HAG - HAGGAI

DEU - DEUTERONOMY ZEC - ZECHARIAH
JOS - JOSHUA MAL - MALACHI

IDG - JUDGES MAT - MATTHEW
RTH - RUTH MAR - MARK

1SA - 1 SAMUEL LUK - LUKE

25A - 2S5AMUEL JOH - JOHN

1K1 - 1 KINGS ACT - ACTS

2KI - 2KINGS ROM - ROMANS

ICH - 1 CHRONICLES 1CO - 1CORINTHIANS
2CH - 2 CHRONICLES 2CO - 2 CORINTHIANS
EZR - EZRA GAL - GALATIANS
NEH - NEHEMIAH EPH - EPHESIANS
EST - ESTHER PHI - PHILIPPIANS
JOB - JOB COL - COLOSSIANS
PSA - PSALMS ITH - 1 THESSALONIANS
PRO - PROVERBS 2TH - 2 THESSALONIANS
ECC - ECCLESIASTES 1TI - 1 TIMOTHY
SON - SONG OF SOLOMON 2T - 2 TIMOTHY
ISA - ISAIAH TIT - TITUS

JER - JEREMIAH PHM - PHILEMON
LAM - LAMENTATIONS HEB - HEBREWS

EZE - EZEKIEL JAM - JAMES

DAN - DANIEL IPE - 1PETER

HOS - HOSEA 2PE - 2PETER

JOE - JOEL 1JO - 1JOHN

AMO - AMOS 2JO - 2JOHN

OBA - OBADIAH 310 - 3JOHN

JON - JONAH JUD - JUDE

MIC - MICAH REV - REVELATION

SONG OF SOLOMON is called SONG OF SONGS in the New
International Version.

Books of the Apocrypha (for the Revised Standard Version)

1ES - 1ESDRAS AZA - PRAYER OF AZARIAH
2ES - 2ESDRAS SUS - SUSANNA

TOB - TOBIT BEL. - BEL AND THE DRAGON
JDT - JUDITH MAN - PRAYER OF MANASSEH
ES2 - ADDITIONS TO ESTHER IMA - 1 MACCABEES

WIS - WISDOM OF SOLOMON 2MA - 2 MACCABEES

SIR - SIRACH 3MA - 3 MACCABEES

BAR - BARUCH 4MA - 4 MACCABEES

JE2 - ADDITIONS TO JEREMIAH PS2 - ADDITIONS TO PSALMS




CHAPTER 2 GETTING ACQUAINTED

This chapter is designed to acquaint you with some of the features of
THE WORD processor family of products. A step by step set of
instructions will show you what to do. So, let's get started!

Follow the instructions in Chapter 1 of this manual entitled, GETTING
STARTED. You will get the Bible text displayed on the screen. At this
point we are ready to begin the session. Please follow the instructions
step by step. Enjoy your "GETTING ACQUAINTED" session. Let's
start with the features included in the VERSE SEARCH product. The
examples are described for the keyboard, but you can also use the mouse
if you prefer.

Step 1 - Paging Forward and Backward

After reading the verses displayed, try the PAGEDOWN key to see more
verses. Try this several times. Then use the PAGEUP key to read
previous verses. Try this several times to get a feel for paging forward
and backward through the Bible text. It is similar to holding a printed
Bible in your hand. One key turns the pages forward and the other key
turns the pages back. You might also try the DOWN arrow key to move
just one verse down in the text and the UP arrow key to move just one
verse up.

Step 2 - Jumping to Any Verse

Now press the F5 key. You are being asked to enter the reference of the
verse you want to see next. Type JOHN 3:16 and press the ENTER key.
The verse you requested will be instantly displayed.

Step 3 - Jumping by Chapters

Press CTRL+END to skip to the next chapter. Try this several times.
Press CTRL+HOME to skip to the previous chapter. Try this several
times.

Step 4 - Choosing a Command from a Menu

Using the Keyboard:
Press ALT+S (hold down on the ALT key and press the S key) to
display the Search menu. Press the S key to choose the Set
BookMark command.

Using the Mouse:
Click on the word Search to display the Search menu. Click on the
Set BookMark command.

A message box informs you that a bookmark has been set on the verse

currently displayed. Press the ENTER key to erase the message.




Step 5 - Searching for a Word

Ready for something a little more exciting? Press the F6 key and we will
go on a "dove" hunt. There is now a small window displaying a list of
the unique words in the Bible. Enter the value DOVE and press the
ENTER key. See, we found a DOVE. To see if there are any more of
them flying about, press the SPACEBAR to continue the search. Try
this several times.

Step 6 - Searching for Anything

Select the F7 key to search for a list of words. Type the word MEN and
press the ENTER key. Type the word MAN and press the ENTER key.
Press ALT+S (hold down the ALT key and press the S key at the same
time) to start the search. The Verse List window shows a list of every
verse in the Bible that includes your search criteria. The text of the first
verse is displayed in the scripture window.

Step 7 - Choosing a Command from a Menu
Using the Keyboard:
Press ALT+F to display the File menu.
Press S to choose the Side by Side command.
Using the Mouse:
Click on File to display the File Menu.
Click on the Side by Side command.
The scripture window and the Verse List window will be displayed side
by side.

Step 8 - The Verse List Window

Use the UP or DOWN arrow keys to highlight any reference in the Verse
List and press the ENTER key. The text for that verse will be displayed
in the scripture window. Try this several times.

Step 9 - Making a Window Active
Notice the title of the Verse List window is highlighted. Press
ALT+TAB. Notice the highlight has moved to the title of the scripture
window. The window with the highlighted title is the active window.
Notice also the menu has changed. Any command you choose will be
directed towards the active window.




Step 10 - Searching for a Prefix

Press F7. Press ALT+E to empty the list of search values. Press ALT+N
to move the cursor to the window labeled "Enter New Search Value".
Enter the value EVER= and press the ENTER key. Then press ALT+S
to begin the search. You can see that we didn't get the word "EVER" but
rather the word "EVERY". The equal "=" specifies to look for the words
beginning with the letters "EVER". Display several verses to see the
variety of words found by this search.

Step 11 - Searching Only a Range

Press ALT+TAB to make the scripture window active. Press F7 to
search. Press ALT+R to display the Range options. Press ALT+N to
select the New Testament only. Press ALT+S to begin the search. This
time only the verses within the range you requested were included in the
search,

Step 12 - Searching for a Concept

Press ALT+TAB to make the scripture window active. Press F7 to
search, Press ALT+E to empty the list of search values. Type the word
SIN and press the ENTER key. Press ALT+M to move the cursor to the
synonym list. Press the ENTER key. All of the first set of synonyms for
SIN will be added to the search list. Press the ALT+S key to begin the
search. Press ALT+TAB to make the scripture window active. Press the
SPACEBAR several times to display the variety of verses found.

Step 13 - Asking for Help

Press the F7 key to start a new search. Press the F1 key for HELP. Use
the cursor keys to browse through the instructions on searching. When
you finish, press the ENTER key to close the HELP window.

Step 14 - Cancel a Command

The Find window is still displayed, waiting for you to enter your search
criteria. but let's choose not to continue. Just press the ESCAPE key to
close the Find window.

Step 15 - Printing

If you don't have a printer, skip this step. Otherwise, be sure it is tumed
on and the paper is properly positioned. Press the ALT key to activate
the Menu Bar. Press the F key to display the File menu. Use the DOWN
arrow key to highlight the Print command. Press the ENTER key. Press
ALT+G to print the last verse displayed.

Step 16 - Quitting
Press ALT+Q to display the Quit menu. Press X to exit.
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Chapter 3 Browsing through the Bible

THE WORD processor is a family of products. The options you see on
each menu are expanded by each product you have installed. The
options for browsing through the Bible are a part of the VERSE
SEARCH product. These options allow you 10 request any verse from
anywhere in the Bible at any time.

When you start THE WORD processor, the Bible translation you last

used will be displayed. You may then browse through the Bible using
either the keyboard or the mouse.

3.1 Using the Mouse

To display other verses from the Bible, click the mouse on the scroll bar.

Clicking on the: Moves the text:

Arrow at the bottom ....... to the next verse down in the Bible
Arrow at the top ............. to the previous verse in the Bible

Bottom half .................... to the next verse down not already shown
Upper half ........ccocovnen.n. 0 5 verses previous in the Bible

3.2 Using the Keyboard

The cursor keys can be used to display other verses from the Bible. The
PAGEDOWN key displays the next page of Bible text. The PAGEUP
key displays the previous page of Bible text. The DOWN arrow displays
the next verse and the UP arrow displays the previous verse. The HOME
key always displays Genesis 1:1. The END key always displays
Revelation 22:21. The following keys can be used while displaying
Bible text:

11




Shortcut Keys: Moves the text:
DOWN .............. to the next verse

UP......coocecureeeen. tO the previous verse
HOME............... to the first verse in the Bible
END................... to the last verse in the Bible

CTRL+HOME... to verse 1 of the previous chapter
CTRL+END...... to verse 1 of the next chapter

Scrolls the window contents:
PAGE DOWN.... Scroll down one screen of verses

PAGE UP.......... Scroll up 5 verses
Control the window:

ALT................... Activate Menu Bar
ALT+F4 ............ Close the window
ALT+FS ............ Restore the window
ALT+FG6 ............ System Settings
ALT+FT7 ............ Move the window
ALT+ES ............ Size the window
ALT+F10........... Maximize the window

ALT+TAB......... Activate the Next Window
ALT+SHIFT+TAR Activate the Prior Window

Use Study Aids: (These are unavailable when grayed.)

Fl......cecees........ Help on what to do now
Fousnannn Cham References

F3......ccceceenen-.... Find next occurrence of search value
F3+SHIFT ......... Find previous occurrence
Betssicinnisnsanus Display last verse shown
F5...cecesieveeenee.. Go to any verse in the Bible
F6......cceceneeueeee.. Search for any word anywhere in Bible
FT7......ceeusuve..... Find any word, phrase, synonym

P8 iciniisinisvinnsss Display a Bible Dictionary
F9.....oeeunueene. Display Personal Commentary

F10.................... Display Greek/Hebrew Dictionary




3.3 Displaying the Verse You Want

The Search menu provides commands to find any verse in the Bible. You
can request display of a specific verse, the next book or the previous
book, or you can set a BookMark and return to that BookMark at any
time.

3.3.1 Go toa Verse Command

The Go To A Verse command displays any verse in the Bible. You enter
the Book, Chapter or Verse you want and the verse you requested will be
immediately displayed. You may enter any verse reference using one of
the following forms:

You May Enter: Example:
Book Chapter:Verse JOHN 3:16

Book Chapter GEN 1
Book GENESIS
Verse 12
Chapter:Verse 12:5

Only the first three letters in Book are used, the remaining letters are
ignored. The book name abbreviations are listed in Chapter 1.

3.3.2 Go to Last Verse Shown Command

The Go to Last Verse Shown command returns to the previous verse
shown, If Genesis 1:1 is displayed and you go to Matthew, this
command will return to Genesis. You can repeat this command to return
to Matthew. This command is similar to an automatic bookmark set on
the last verse shown.

3.3.3 Previous Chapter Command
The Previous Chapter command displays the first verse of the previous
chapter in the Bible.

3.3.4 Next Chapter Command
The Next Chapter command displays the first verse of the next chapter in
the Bible.

3.3.5 Previous Book Command
The Previous Book command displays the first verse in the previous
book in the Bible.

3.3.6 Next Book Command
The Next Book command displays the first verse in the next book in the
Bible.
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3.3.7 Go to BookMark Command
The Go To BookMark command displays the verse where you last set a
BookMark. If no BookMark has been set, the command is ignored.

3.3.8 Set a BookMark Command

The Set a BookMark command sets a BookMark at the verse currently
displayed. When the Go To BookMark command is chosen, this verse
will be displayed again.

3.4 Opening More Scripture Windows

You may open more windows to display scripture text. Each window
can display different verses or even different translations. The File menu
provides commands to open new windows for displaying scripture text
or to close a window.

3.4.1 Open Scriptures Command

When you choose the Open Scriptures command, a new window will be
opened displaying Bible text. You may open as many scripture windows
as your computer allows. Each new window will display the same verse
in the same translation as the last active scripture window. You may use
the Translation menu to choose a different translation to be displayed in
the new window. If no scripture windows are open when you choose the
Open Scripture command, you will be asked to choose which translation
you want. If a translation is not available, the name will be grayed.

3.4.2 Close Command
The Close command closes the active window.

3.4.3 Side by Side Command

When more than one scripture window is shown, you may choose the
Side by Side command to automatically position up to four windows
side by side and of equal size. If more than four scripture windows are
open, the extra windows will not be affected.
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3.5 Changing Bible Translations

The Translation menu allows you to choose which translation of the
Bible you want displayed. The active window will be changed to
display the same verse in the new translation. The translation name will
be checkmarked on the menu to show that translation is being displayed
in the active window. If a translation is not available, the command will
be grayed.

3.5.1 King James Command

3.5.2 New International Command

3.5.3 New King James Command

3.5.4 Revised Standard Command

These commands allow you to choose the translation of the Bible to be
displayed. The active window will be changed to display the same verse
in the translation you requested. If the translation is not available, the
command will be grayed.

3.5.5 NIV Footnotes Command

The NIV translation includes footnotes provided by the original
translators. You may choose to have these footnotes displayed along
with the text of each verse by selecting this command. A checkmark
beside the NBY Footnote command shows this option has been turmed
on. When you choose this command again, the checkmark will be
removed and the footnotes will not be shown.

3.5.6 Synchronize Command
The Synchronize command is used to coordinate the display of multiple
translations. When you select this command, the menu item will be
checked. You may select this command again to remove the check. To
synchronize:

open more than one scripture window,

display a different translation in each window,

select the Synchronize command.
Each time a window becomes active, the verse shown in the previous
window will be shown in the new translation.
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3.6 Comparing Bible Translations

While you are displaying your primary translation, you may choose at
any time to compare it with the verses in another Bible translation. Use
the Open command on the File menu to create a new window of Bible
text. Use the Translation menu to choose another translation for the text
in the new window. Then choose the Side by Side command to display
the two windows together. You may then browse through the Bible
comparing verses from the two translations.

You may use the Synchronize command on the Translation menu to tie
the windows together. Each time you make a text window active, it will
automatically display the same verse shown in the last active text
window.

3.7 Crossing Record Boundaries

You may some times get only a partial screen when displaying text. This
occurs when the end of the text record currently in memory has been
reached. The next PgDn command will cause the program to read
another record from disk into memory and the screen will once again be
full. A similar situation occurs when the top of a record is reached. A
PgUp command may move up less than 5 verses when the top of a text
record is approached. A PgUp command from the top of a text record
causes a read of the previous record and displays only the last verses at
the end of that record.
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Chapter 4 Printing Bible Text

4.1 Controlling the Position of the Printer Page

THE WORD processor is designed to allow you to print cumulatively.
That means you can print a verse, browse awhile, print another verse,
print your lesson text and print another verse all on the same page. To
do this, THE WORD processor needs to always keep track of what has
been printed so far and how much more can be printed on the same page.

When you start THE WORD processor, it assumes the printer is properly
positioned at the top of a page. Each line printed is counted and page
breaks occur automatically when the page is full. For some Bible
translations the copyright notice is printed at the top of every printed
page as required by the copyright holder. The position of the paper in
the printer should always be under the control of THE WORD processor.
Every Print request allows you to instruct THE WORD processor to
position the paper as follows:

FORM Button
Select the Form button to eject the page in the printer to the top
of the next form.

LINE Button
Select the Line button to print a blank line.

ALIGN Button

If you manually alter the paper position in your printer, you need
to select the Align button to tell THE WORD processor 1o reset
its line counter to start a new page.
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4.2 Printing One Verse
Choose the Print command on the File Menu. Select the Go button. The
verse shown at the top of the scripture window will be printed.

4.3 Printing a Range of Verses

Choose the Print command on the File menu. Select the Range of Verses
option. Select the Range button and set the range to whatever verses you
want to be printed. Then select the Go button.

4.4 Printing a Verse List

When the Verse List window is active, you may choose the Print
command on the File menu. There are several options for you to choose
what portions of the Verse List you want to print.

4.4.1 Printing References Only
Select the Go button. The references in the Verse List will be printed.

4.4.2 Printing References with Text
Select the Print References with Text option. Then select the Go button.

4.4.3 Printing Only a Portion of the Verse List

Select the Within Range option. Use the Range button to specify any
range of Bible verses. When you select the Go button, only those verses
from the list that are within the range you specified will be printed.
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4.5 Options While Printing

Including Personal Commentary with each Verse

If you have saved personal comments with the verses using the Personal
Commentary product, you may choose to include your comments with
the verses being printed. Select the Personal Commentary option.

Highlighting Search Values

You may select this option to have search values highlighted on the
printed page. Because each brand of printer is different, you must set the
correct codes for your printer to highlight. (see Printer Setup)

FILE Button
The File button directs the print to an ASCii file rather than to the
printer. For further instructions, see the chapter on the ASCii utility.

LAYOUT Button

The Layout button displays the same options as the Page Layout
command on the File menu. It is here only for your convenience in
making last minute changes.

SETUP Button

The Setup button displays the same printer options as the Setup
command on the System Settings dialog box. It is here only for your
convenience in making last minute changes to the printer hardware
configuration.

4.6 Cancel Printing

You may cancel the printing operation at anytime. The current page and
line number being printed will be displayed. Just choose the Cancel
button or press the ESCAPE key.

Many printers are "buffered" printers. This means they may have
received information that has not yet been printed. The Cancel command
stops the sending of information to the printer: however, information
previously sent, but not yet printed will continue to print until all the
information that has been sent has been printed. Do not be disturbed if
your printer continues to print for a while after you have cancelled the
operation. You will know that sending text to the printer has stopped
when the dialog box has been removed from the screen.
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4.7 Page Layout Command

The Page Layout command on the File menu allows you to describe the
format you want for printing. Set each of the options as you want and
select the Ok button.

Top Margin

Bottom Margin

Left Margin

Right Margin

Page Length

Spacing

Full BCV Ref

Enter the number of blank lines you want at the top of
each printed page. If you want no blank lines, enter a
zero (0).

Enter the number of blank lines you want at the bottom
of each printed page. If you want no blank lines, enter a _
zero (0).

Enter the number of the column where you want
printing to begin. If you want no blanks on the left
margin, enter a one (1).

Enter the number of the column where you want
printing to stop. If you want no blanks on the right
margin, enter eighty (80).

Enter the number of lines available on your paper. The
default is 66 on a page. You should change this only if
you are using special paper or a laser printer with a
different page size. If you set Page Length to zero (0),
the top and bottom margins will be ignored, and if you
are writing to a file, all formatting will be ignored except
a break between verses.

Enter:

a 0 for normal printing, or

a 1 for one blank line (double spacing), or
a 2 for two blank lines (triple spacing).

The verse at the top of each page is always printed with
a full book, chapter and verse reference. Other verses in
the same chapter have only a verse number. If you want
every verse to have a complete reference, select this
option.




4.8 Printer Setup Button

The System Control Menu Box (the symbol in the upper left corner of
your screen) allows you to customize for your computer configuration
and personal preferences. To access the System Control Menu:

Using the keyboard: press the Alt,SHIFT+SPACEBAR keys
Using the mouse:  click the mouse on the System Control Menu Box

To customize for your printer, select the Printer Setup button and specify
the following:

LPT1, LPT2, LPT3, COM1, COM2 Options
These options allow you to specify the port to which your printer is
attached. This is usually LPT1.

Page Feed Continuous Option
Choose this option if you will be printing on continuous paper or forms.

Page Feed Manual Option

Choose this option if you will be manually feeding paper to your printer.
You will be prompted at each new page, asking you to feed the next
sheet.

Auto Line Feed Option

Some printers have an Auto Line Feed option. That means the printer
automatically interprets a carriage return character as a carriage retun
plus a line feed character. If printing unexpectedly double spaces your
output, check this option to print correctly single spaced.

Test Ready Status

Usually your printer will be tested prior to attempting to print on it. If
the printer is not powered on, in ready state, with paper, a message will
inform you. On some systems, even when the printer is ready to use, the
test does not function correctly. When you tumn this option off, testing of
your printer will be bypassed.
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Initialization

Select this text box and enter any special characters you want to send to
the printer before printing begins. You may enter any character you want
to send to the printer. If you choose to specify a decimal code, start each
code with a backslash. If you enter more than one character, separate
each character with a comma. Each printer uses different codes. For
example, to print in condensed mode on an Epson printer, enter the
following:

\015

To print in Near Letter Quality on the Epson printer, enter the following:
\027,x,1

See the manual for your printer for specific codes.

Highlight ON

You may enter any instructions you want to send to the printer to
highlight the search criteria being printed. If you leave this blank, no
highlight will be printed. You may enter any instructions valid for your
printer. For example, on the Epson printer, the highlight is turned on
with the following codes:

\027,\069

Highlight OFF

You may enter any instructions you want to send to the printer to turn off
the highlight after a search criteria has been printed. You may enter any
instructions valid for your printer. For example, on the Epson printer,
the highlight is turned off with the following codes:

\027,\070
See the manual for your printer for specific codes.

[ ]
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Chapter 5 Searching the Bible Text

Searching the Bible begins with the Search menu. There are several
commands for both simple and complex search requests. Any of the
search commands will display the verse you requested with the search
criteria highlighted. Every search request builds a Verse List containing
the reference of every verse that satisfied your search request.

5.1 Searching for a Word

The Find a Word command is the simplest way to search the Bible. It
finds any word anywhere in the Bible. When you choose the Find a
Word command, a list of all unique words in the Bible will be displayed.
You may highlight any word by:

moving the cursor, or
clicking the mouse, or
typing the word.

When the word you want to find is highlighted, just press the ENTER
key (or double click the mouse). A Verse List will be created that
includes every verse in the Bible that contains that word. The first verse
in the list will be displayed. You can use the Find Next command to
continue the search for another verse, or you can use the Show List
command to display the entire Verse List.

As you type a sequence of letters, the list will show the first word
beginning with that sequence. For example, if you type a C, the list will
show the first word beginning with the letter C. If you then type an I, the
list will show the first word beginning with the letters CI. To start typing
a new word, enter a blank (or any non-letter key).

Note about NIV translation: The list of unique words for the NIV
translation includes words that only occur in the footnotes. These words
are not included during a search.

MORE Button

If you decide you want to search on something more than just a word,
select the More button to display the Find Anything window. Then your
search can be broadened to include phrases, word lists or synonyms.
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5.2 To Continue a Search

FIND NEXT command

The Find Next command finds the next occurrence of the search values
you requested previously. A Find a Word or Find Anything command
must be used first to specify the values you want to find and to find the
first occurrence. Then you may use the Find Next command to continue
the search. The Find Next command starts at the verse currently
displayed and finds the next verse that is in the Verse List.

FIND PREVIOUS command

The Find Previous command finds the previous occurrence of the search
values you requested previously. Either a Find a Word command or a
Find Anything command must be used first to specify the values you
want to find. Then the Find Previous command will find the first verse,
previous to the verse currently displayed, that is in the Verse List.
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5.3 Show List of All Verses Found

The Show List command on the Search menu displays a list of verses
that contain the search values you last entered. The count of references in
the list is always displayed. You may select verses from this list for
display or print. You may highlight any verse in the list by using the
cursor keys or using the mouse.

You may press the ENTER key (or double click the mouse) to see the
text of the highlighted verse. If you choose the Print command on the
File menu, you may print the list of verse references or print the text of
all verses in the list.

INSERT Button
When you select the Insert button, you will be asked to enter a verse
reference. The verse you enter will be added to the Verse List,

If the Verse List is sorted:
the new verse will be inserted in the same sequence as the Bible,
duplicates will be ignored.

If the Verse List is unsorted: (using the LIBRARIAN product)
the new verse will be inserted after the highlighted verse
in the Verse List, duplicates will be allowed.

To insert a range of verses, add a dash to the reference. For example:
JOHN 1:1-5 will add all verses 1 through 5
JOHN 2- will add all verses of chapter 2
JOHN 2-3  will add all verses of chapters 2 and 3
JOHN- will add all verses of JOHN.

DELETE Button
When you select the Delete button, the highlighted verse will be deleted
from the Verse List.
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5.4 Find Anything Command

The Find Anything command allows you to enter a list of things you
want to find. You may choose any range of verses to be included in the
search. Then select the Search button. Each verse in the range that
contains your search criteria will be shown in a Verse List. The first
verse found will be displayed with the search values highlighted. You
may select from several options to specify exactly what you want to find:

SEARCH VALUES
This list shows what will be searched for. You may add to this list by:
selecting words from the UNIQUE WORDS list,
selecting synonyms from the THESAURUS,
entering words, phrases, prefixes.
When you select the Search button, everything in this list will be
searched within the range of verses you specified.

UNIQUE WORDS

Every unique word in the Bible is included in the list. You may highlight
any word by using the cursor keys, or using the mouse, or typing the
word. Press the ENTER key (or double-click the mouse) to add the
highlighted word to the list of SEARCH VALUES.

SYNONYMS

Each unique word in the UNIQUE WORDS list may have a list of
synonyms in the THESAURUS. If you select any word in the
THESAURUS, that word will be added to the list of SEARCH
VALUES. The words in the THESAURUS are grouped by general
meanings. Each group is identified by a Group Number. If you select a
Group Number from the THESAURUS, all words in that group will be
added to the list of SEARCH VALUES.

ENTER NEW SEARCH VALUE

You may enter any word, any phrase, any prefix. If the value you enter
is not found in the Bible, you will be told immediately. Otherwise, it will
be added to the list of SEARCH VALUES.




SEARCH FOR ANY VALUES IN ANY VERSE

If you enter more than one value in the SEARCH VALUES list and
select this option, all verses within the range will be searched for any
occurrence of any of the search values.

SEARCH FOR ALL VALUES IN THE SAME VERSE

If you enter more than one value in the SEARCH VALUES list and
select this option, only verses within the range that contain all the search
values will be selected.

ADD Button

When you select the Add button, something will be added to the list of
SEARCH VALUES. What gets added depends on where the cursor is.
If the cursor is in the UNIQUE WORDS list, the word will be added. If
the cursor is in the ENTER NEW SEARCH VALUE box, the value you
typed will be added. If the cursor is in the SYNONYM list, the
synonyms will be added.

DELETE Button
When you highlight a word in the SEARCH VALUES list and select the
Delete button, the highlighted word will be deleted from the list.

EMPTY Button

When you select the Empty button, all search values in the SEARCH
VALUES list will be deleted. The list will be empty and ready for you to
enter a new set of search values.

RANGE Button
When you select the Range button, you may choose any range of verses
in the Bible to be included in the search.

SEARCH Button

When you select the Search button, all verses within the range you
specified will be searched for the values shown in the SEARCH
VALUES list. A list of every verse that is found will be displayed. The
text of the first verse found will be displayed with the search values
highlighted.

CANCEL Button
If you change your mind, select this command to return to the text
window without searching.
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PROXIMITY

When the SEARCH VALUES list contains two search values and you
select the option to FIND ALL OF THESE IN THE SAME VERSE, the
search will find only those verses that contain both of the search values.
However, you may want to find all verses where the search values occur
close to one another, but not necessarily within the same verse. If you
set the proximity to 1, each verse that contains one of the search values
will be accepted if the other search value occurs 1 verse before or after.
You may increase the proximity to find more verses that use the search
values further apart. For example, search for ANGEL and GRACE and
set the proximity at 2, then search again with the proximity at 6. In
general, the higher you set the proximity, the more verses will be found.
The maximum proximity is 99 verses.
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5.4.1 Searching for a List of Words

Select the Find Anything command from the Search menu. Highlight any
word in the Unique Words list and press the ENTER key to add that
word to the Search Values list. Repeat this for every unique word you
want to find. Then select the Search button.

5.4.2 Searching for a Phrase

Select the Find Anything command from the Search menu. Press the
TAB key (or click the mouse) to move the cursor to the ENTER NEW
SEARCH VALUE box. Type the phrase you want to find (up to 250
characters) and press the ENTER key to add that phrase to the Search
Values list. Then select the Search button.

5.4.3 Searching for a Prefix

Select the Find Anything command from the Search menu. Press the
TAB key (or click the mouse) to move the cursor to the ENTER NEW
SEARCH VALUE box. Type the leading characters and add an equal
(=) sign. The equal indicates the next letter can be equal to anything.
All words that begin with the leading characters will be included in the
search. For example, to find baptized or baptism or baptizing or baptists,
just enter: BAPT=

5.4.4 Searching for a Concept using THESAURUS

Each unique word in the UNIQUE WORDS list may have a list of
synonyms in the THESAURUS. As you are choosing what words you
want to find, the synonyms may be used to stimulate your thinking about
other words that might also apply to your studies. If you select any word
in the THESAURUS, that word will be added to the list of SEARCH
VALUES.

The words in the THESAURUS are grouped by general meanings. Each
group is identified by a Group Number. If you select a Group Number
from the THESAURUS, all words in that group will be added to the list
of SEARCH VALUES. You may choose to make your search narrow or
broad depending upon the synonyms you choose to include in the
search.
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5.4.6 Searching Only a Specified Range of Verses

Select the Find Anything command from the File menu. Select the Range
button. You may enter any beginning and ending verse references using
one of the following forms:

You May Enter: Example:
Book GEN

Book Chapter GEN 1
Book Chapter - Chapter EXO1-5
Book - Book GEN - REV
Book Chapter:Verse GEN 1:1
Book Chapter:Verse-Book Chapter:Verse GEN 1:1-REV 22:21
Chapter:Verse - Chapter:Verse 3:1-5:21
Chapter:Verse 51

Verse - Verse 3-5

Verse 3

Only the first three letters of the Book are used, the remaining letters are
ignored. The book name abbreviations are listed in Chapter 1.

5.5 Instant Access

Bible Research Systems has pre-searched every word in the Bible and
recorded in a product called INSTANT ACCESS where each word
occurs. With INSTANT ACCESS installed, any word anywhere in the
Bible will be found instantly with no delays for searching the text.
Whenever speed is important, INSTANT ACCESS reduces the time to
seconds to find any word in the Bible,

INSTANT ACCESS also improves the speed of searching for a phrase.
INSTANT ACCESS can identify what text contains all words included
in the phrase. Then VERSE SEARCH searches only those verses to
determine if those words are in the proper sequence you specified in the
phrase.
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Chapter 6 The ASCii Utility

The purpose of the ASCii Utility is to allow the user to integrate
scripture text with other text written by the user. Any portion of the
Bible text can be copied in a format readily accessible to other word
processing software.

Most users of personal computers are familiar with one or more word
processing software programs. A word processor is typically the first
program purchased and one of the highest priced software investments.
After using a word processor frequently on a variety of applications, the
user becomes very familiar with how to use his word processor (which
keys perform which function) and strongly prefers his word processor
over learning another one for a special task. The ASCii utility allows
access to scripture text using the word processor you are already familiar
with. As you prepare a sermon, lesson or notes, scripture text can be
incorporated into your document with minimal effort.

Every software product has different methods for storing text. Your word
processor stores data in a different format than any other word processor.
A document written and saved on disk by your word processor cannot be
read by other brands of word processors. This problem was resolved
some years ago by the adoption of a standard data format called ASCii.
Most software writers have agreed to support not only their own special
format but also the standard ASCii format. Data stored in the ASCii
format by one software product can be read by other software products
that support the ASCii standard. The ASCii Utility writes selected
scripture text to your disk in standard ASCii format with no control
characters. It is your responsibility to determine if your word processor
can read a standard ASCii text file.

6.1 Creating an ASCii Text File
To create an ASCii text file, you must start with any PRINT command.
Anytime you request a Print of anything, the Print dialog box will

include a File button. When you select the File button, the text you
requested will be written to a disk file rather than the printer.
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The format of the scripture text written to disk can be controlled either
by THE WORD processor or by your word processing software. If the
Printer Lines per Page on the Page Layout is set to zero, the text will be
written to disk with no format controls. This allows your word
processing software to format the scripture text in the same format as
your other text. If the Printer Lines per Page is set to anything other than
zero, the left/right margins defined on the Page Layout determine the
format of the text.

When you select the File button, you may enter the name of the file to
store the ASCii text. You may want to choose a name that conforms to
the unique file name requirements of your word processing software. If
you enter a name that does not currently exist, a new file will be created
with the name you entered. Any previous ASCii file is still available.
You may create many different ASCii files each containing whatever text
you desire.

If you enter the name of a file that already exists, you may choose to;

Start a New File
Add to End of File

If you choose Add, all text will be added to the end of the file. If you
choose New, any content of the existing file will be erased.

6.2 Using an ASCii Text File

When you end the session with THE WORD processor, the text you
requested is available on the disk file in ASCii format, If you want to see
what is on the ASCii text file, try using the DOS command, called
TYPE, as follows:

TYPE TEXT.TXT  (or your file name)

The contents of the file will be displayed on the screen. To edit the file
yourself, start your word processing program and use the functions of
your word processing program to load the ASCii text. All the functions
of your word processing program are now available for access to the
scriptures.

Bible Research Systems offers another product called VERSE TYPIST
that transfers Bible text to your word processor dynamically. While you
are in the midst of writing your lesson, you can request any Bible text.
Those verses will be inserted into your lesson text just as if you had
typed them yourself.




Chapter 7 Basic Skills

This chapter is intended for anyone who is not already familiar with the
standard IBM interface. New terms and concepts are discussed here that
will help you better understand how to use THE WORD processor
family of products or any other product that uses this standard. If you
are already familiar with this interface, you may still find this chapter
helps to define the terminology and general functions of THE WORD
Processor.

7.1 Screens and Windows
7.1.1 Screen Layout

The screen is composed of:
a Menu Bar on the top line of the screen,
an area called the Desktop which contains one or more Windows,
a Status Line on the last line of the screen.

Menu bar ->| = File Search Translations Windows Fi=Help
> =—Windouw Title Bar——
X000 XXX XAXXK XNXX XX |
Hindow—————=>| xx XX XXX XX XX i
Desktop XN AXX XX
AN OO XHXX P
>
Status Line->|TEXT ICSN
Menu

A menu is a list of commands. It works just like a restaurant menu. You
look over the list and choose what command you want to use next. The
commands available on each menu may change depending on the
function you are using.
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Menu Bar -)| = File |Edit| Search Windows Fi=Help

Cut Shift+Del
Henu —-=>| Copy  Ctrl+Ins
Paste Shift+Ins
Clear Del
Command

You use commands to say what you want to do. For example you use
one command to save a file and another command to print it.

Desktop
The Desktop includes all lines of the screen except the top and bottom
lines. The Desktop may contain one or more windows.

Window(s)

A Window is a bordered area of the screen where information is
displayed and work takes place. Each command will perform its function
within the boundaries of a Window. If necessary, the command will
create and display the windows needed to perform the function you
requested.

Status Line

The bottomn line always displays the Status Line. The left end of the
Status Line always shows which function is currently active. The right
end of the Status Line always shows the keyboard status. A letter will be
shown if the INSERT (I), CAPS LOCK (C), SCROLL LOCK (S) or
NUM LOCK (N) keys are locked on. Blanks indicate these keys are off.

34




7.1.2 Window Layout

A window is a bordered area of the screen used to display information.
One or many windows can be displayed simultaneously. Windows may
overlap one another. Some windows may cover others entirely. Windows

may be sized and moved to allow multiple windows to be totally in view.

When more than one window is displayed, only one of the windows will
be "active"”. All commands apply to the active window.

Each window has these characteristics:

Control r— Restore Box
Menu Box-> =——Hindow Title Bar—=> <- Maximize Box

Information E ¢- Uertical Scroll Bar
v

Rw Sizing Box
Horizontal Scroll Bar

Window Title Bar

The top border of the window contains the title. The title for a window
displaying Bible text will be the name of the translation. If the window
is active, the title is highlighted.

Control Menu Box

The Control Menu Box is used to access the Control Menu to perform
window moving, sizing and closing commands. These functions are
described in the "Advanced Skills" section of this manual.

Maximize Box
The Maximize Box is used to expand the window to occupy the full
Desktop. Refer to "Advanced Skills".

Restore Box

The Restore Box is used to restore the window to the size it was before
you last used the Maximize Box. Refer to "Advanced Skills".
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Vertical Scroll Bar

The vertical scroll bar has direction arrows at each end and contains a
scroll box that moves up or down to indicate a relative position in the
information. When the top of the information is displayed, the scroll box
will be at the top of the vertical scroll bar. When the bottom of the
information is displayed, the scroll box will be at the bottom of the
vertical scroll bar. The mouse can be used to scroll through the file by
clicking on the scroll bar symbols. Refer to "Operating Scroll Bars with
a Mouse" for a description of this operation.

Horizontal Scroll Bar

The horizontal scroll bar has direction arrows at each end and contains a
scroll box that moves left or right to indicate a relative position in the
information. A leftmost position of the scroll box on the horizontal
scroll bar indicates that the cursor is near the left margin of the
information. A rightmost position indicates that the cursor is near the
right margin. Refer to "Operating Scroll Bars with the Mouse" for a
description of this operation.

Sizing Box

The Window Sizing Box can be used to enlarge or shrink the size of the
window. Refer to "Advanced Skills".
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7.1.3 Operating Scroll Bars with the Mouse

The information you are working with at any given time may be larger
than the window. That means only a portion of the information can be
displayed in the window at one time, The vertical and horizontal scroll
bars can be used to move different portions into the window for display.

Vertical Scroll Bar

A Vertical scroll bar forms the left border of a window and looks like
this:

(— Up direction arrou head
(— Topnost position of scroll bar

¢(— Scroll Position indicator
(has different contrast than the bar itself)

(— Bottommost position of scroll bar
¢— Doun direction arrou head

€ ERWINNNE N >

Horizontal Scroll Bar
A Horizontal scroll bar forms the bottom border of a window and looks
like this:

>
I— Right direction arrow head
Rightmost position of scroll bar
Scroll Position Indicator
Leftmost position of scroll bar
Left direction arrow head

Direction arrow heads.
Clicking the mouse on a direction arrow head scrolls the data in the
window in the direction indicated by the arrow.

Scroll Position Indicator

The scroll position indicator shows the position of the portion currently
displayed relative to the beginning or end of the data. Clicking on the
position indicator and dragging it to a new position on the scroll bar
causes the portion of data at the new position to be displayed.
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Areas on each side of Scroll Position Indicator

Clicking the mouse in the vertical scroll bar above/below the Scroll
Position Indicator will page the window up/down in the data. Clicking
the mouse in the horizontal scroll bar left/right of the Scroll Position
Indicator will page the window left/right in the data.

Scroll bar extreme positions
Dragging the position indicator to these positions will scroll the window
to the extreme position in the data (top, bottom, left and/or right).

Scroll Bar Controls

Another type of scroll bar is used for control options. With scroll bar
controls, no scrolling occurs, the scroll position indicator is simply used
to convey the setting of an option on a range of possible settings.

7.2 Menus and Commands

Commands tell what you want to do. All commands are organized into
menus. The names of the menus are shown on the menu bar. The menu
bar contents will change based on the function that you are using. The
action of picking a menu is called "selecting a menu". The action of
picking a command is called "choosing a command".
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MENU SYMBOLS
Several indicators are used in the menu to give you information about
commands in the menu. The following menu is used to illustrate these

indicators.

Studyhids I

CheckMark —> |J4 Shouw Strong’s NHumbers
Find Strong’s Numbers... <— Ellipsis

Greek/Hebrew Dictionary... F10]<{— Shortcut Keys
Word Origin Analysis

Grayed >| Personal Commentary...

Checkmark

Some commands are used to set options. Each time a menu is displayed,
a checkmark will appear next to a command if that option is currently set
on. You may choose the command again to set that option off.

Emphasized letter

One letter in each of the menu names and command names will be
emphasized. (On color screens this letter will appear in a color different
than the rest. On monochrome screens this letter will be intensified.) This
letter can be used to select the menu or choose the command.

Grayed

Commands that are displayed in a lighter color indicate that the
command is not available at this time. For example, the Paste command
is grayed until something has been placed in the clipboard which can be
pasted. These commands cannot be chosen. A simple beep will wam if
you try to choose a grayed command.

Ellipsis (...)

Some commands are followed by ellipsis (...). This notation indicates
that the command will prompt you for additional information in a
"Dialog Box" before proceeding with the request. For example the Open
command on the File menu will ask you to supply a file name before it
can proceed with your request.

Shortcut Keys

Some commands are followed by key names. These keys can be used as
a shortcut method of choosing the command. Once you have gained
some experience, you may want to use shortcut keys to choose
commands without accessing the menu.
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7.2.1 Selecting a Menu and Choosing a Command

You can select a menu from the Menu Bar and choose a command to
carry out your desired action by using one of these methods:

Basic Method by pressing ALT and DIRECTION keys.

Direct Method by pressing ALT and the emphasized letter in name.

Mouse Method by pointing the mouse pointer to the desired name
and clicking the button.

Basic Method

To select a menu, the Basic Method uses the DIRECTION keys to move
across the Menu Bar and up and down the menus. To use the Basic
Method, perform the following:

1. Press the ALT key. A highlight will appear on the first menu name.

2. Press LEFT or RIGHT to move the highlight on the menu bar. As
you move the highlight messages appear on the Status Line
describing the actions performed by the menu name under the
highlight.

To choose a command, you use UP or DOWN, The list of commands
for the menu will appear and the highlight will move to the first
command in the list. The UP and DOWN keys move the highlight to the
other commands in the list. Again, as you move the highlight, a message
will be displayed on the Status Line describing the actions of that
command. When the highlight is resting on the command you want to
choose, press the ENTER key.

Once you have selected a menu, LEFT and RIGHT change just a bit.
They now are used not only to move you across the Menu Bar but also to
select the menu as they move. By doing the following, you can preview
all of the actions provided by all of the commands.

1. Press the ALT key. This highlights the first menu name.

2. Press the DOWN key. This selects the first menu and highlights the
first command. The Status Line describes the actions performed by
that command.

3. Press the DOWN key for each of the commands in the menu and read
the Status Line describing the actions performed by the command
that is highlighted.

4. After you have examined all of the commands in the menu, press
the RIGHT key. The first menu will disappear and the next menu will
appear with the highlight on the first command of the menu. Press
the DOWN key repeatedly, pausing to read the Status Line
description for each of the commands in that menu.
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Canceling the Menu

If you decide not to select a menu nor to choose any command from the
menu, press ESCAPE. This will cancel your menu selection and return
you to where you were prior to pressing the ALT key.

The ALT key may also be used for this purpose. If you have selected a
menu, pressing the ALT key will return you to menu selection mode, and
pressing the ALT key in menu selection mode will terminate your menu
selection request.

Direct Method

To select a menu, the Direct Method involves using the ALT key and the
keys corresponding to the emphasized letter in the menu and command
names.

1. Press the ALT key. This highlights the first menu name.

2. Press the key corresponding to the emphasized letter of the menu
name you wish to select. This displays the menu for that name.

3. Press the key corresponding to the emphasized letter of the
command name you wish to choose. This chooses the command.

To choose a command, the Direct Method requires fewer keystrokes than
the Basic Method and yet it displays all of the information necessary to
help you select the appropriate menu and command letters. You can
switch freely between the two methods. For example, you can use the
Direct Method to select a menu and the Basic Method to choose a
command.

7.2.2 Shortcut Keys

Many of the frequently used commands have been assigned "shortcut
keys". These keys can be used to choose commands entirely without the
menu. When a shortcut key is available for a command, the key name is
displayed in the menu following the command name. To use a shortcut
key, simply press the key or key chord. You do not, and should not,
select the menu first using the ALT key, as you do with both the Basic
and the Direct Methods.

Shortcut keys provide fast command access without using the menu at
all. They are intended to provide the experienced user with a fast way to
perform the familiar actions. They are simply a substitute for the menu
selection and command choosing that is faster because the menus are not
displayed or highlighted.
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Since the menus are not displayed when you use shortcut keys, you will
have to remember the key(s) to be pressed for a given command. You do
not have to bother attempting to consciously memorize these keys and
commands. The more you use the Basic and Direct Methods of choosing
commands, the more you will be exposed to the key names for the
shortcut keys. When you have become familiar with the commands
themselves, you will become familiar with the shortcut key for the
command. Use the ones you can remember and rely on the Basic or
Direct Methods for the others.

7.2.3 Operating Menus with the Mouse

You can use the mouse to select a menu and choose commands. Follow
this procedure.

1. Point the mouse to the desired menu name on the Menu Bar. Click
the mouse button. This selects the menu under the mouse pointer.

2. Point the mouse to the desired command in the menu. Click the
mouse button. This chooses the command under the mouse pointer.

To cancel menu selection using a mouse, simply move the mouse pointer
to a location outside the rectangle which contains the menu of commands
and click the mouse button. The menu will disappear and you will be
returned to where you were before you selected the menu.

If you need a reminder of which functions are performed by the various
commands, you can review a description of the commands in the Status
Line by dragging the mouse across the menu.

1. Point the mouse to any menu name on the Menu Bar and press (do
not release) the mouse button. A menu will pop up.

2. With the mouse button still depressed, move the mouse up and
down the menu. The command descriptions will be displayed on the
Status Line as the mouse moves over a command in the menu.

To pull down other Menus:
3. With the mouse button still depressed, move the mouse to the
desired name on the Menu Bar. Its menu will pop up.

To choose a command:
4. Release the mouse button while the mouse pointer is over a
command.

To cancel menu selection:
5. Move the mouse pointer to a location on the screen outside of any
menu and release the mouse button.
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7.3 Dialog Boxes

Dialog boxes are a method of obtaining more information from you in
order to perform a command. Commands which require more
information are displayed in the menu with ellipsis (...) following the
command name. This information tells you that you will be prompted
for more information prior to carrying out the command.

Dialog boxes appear in a rectangular area in the center of the screen.
The title bar of the dialog box tells you which command you have
chosen. Additional information inside the dialog box are called
"controls”. Controls are used to:

1. Inform you of the default and/or currently selected command
options.

2. Obtain more information from you. Allow you to modify the
current option settings.

3. Allow you to proceed with the command or cancel its execution.
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Several dialog boxes are illustrated here to show you the type of controls

that are used.

Option
Buttons

=

Command Buttons—>

———————=30rt Options
—Choose one of these:
(8) Sort in Biblical order

( ) Allow verses in any order

Cancel

Lo |

File Name: |[=.txt

File Upen;I—l

Directory: C:\
$ilasb————————1

SERMONSS . txt
LESSON. txt
STUDYAID. txt
WORKDDC . txt

TODO. txt
NDTES.txt v

Cancel

Text Box >
List Box >
Menwu Bar ——>
Scroll Bar >
Check Box >

Command Buttons->

ystem Settings
Setup Preferences

Fast

Double Click———
Slow

[ 1 Swap Buttons <Test>

Cancel

[ ]
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Dialog boxes have one or more of these controls:

Command Button

Each dialog box has at least one command button. The command button
is used to instruct the program to perform a command or to cancel the
dialog. A command button is a rectangular area labeled with the
command it is to perform. For example the Cancel button cancels the
command while the Ok button performs the command with the options
you have provided. Occasionally, command buttons are displayed as
button labels between angle brackets (<button label>) to conserve screen
space. Whether the button is displayed as a rectangle or within angle
brackets, its function is the same.

If there is more than one command button, one of the buttons is the
"default” button. This button defines the command that will be
performed if you press the ENTER key. The " default” command button
is always displayed with a double line border. In each of the above
examples, the Ok button is the default. As you select command buttons,
the selected button becomes the new default and its border is changed to
a double line border. The command that takes effect when you press the
ENTER key is always the button with the double line border. When you
select a control that is not a command button, the original default button
is restored to its original status.

Option Button

Option buttons are used to allow you to select one of several options.
Only one of the options can be selected. A dot beside an option
indicates that the option has been selected.

Check Box
You turn an option on or off using a check box. An X inside a check
box means that the option has been turned on.

Scroll Bar

You specify an option as a location on a scale of available values by
using a scroll bar. For example you select the time allowed for a Double
Click on a range between fast and slow by positioning the scroll
indicator on the Double Click scroll bar.
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List Box

You select one item from several presented in a list box. For example,
you may select the file you wish to open from the files list box. The
selected item in the list is highlighted. List boxes have vertical scroll
bars that allow you to scroll through the options in the list prior to
making a selection.

Text Box
You type text in a text box. For example, you type the name of the file
you wish to open in the File Name text box.

Option buttons, check boxes, text boxes, list boxes, and scroll bars are
collectively referred to as options. You select and set options the way
you want them and then choose the appropriate command button to carry
out the command.

Performing a Command from a Dialog Box
To carry out a command from a dialog box:

1. Set the options the way you want them,
2. Choose a command button to carry out the command.

To cancel a dialog box without carrying out the command, choose the
Cancel button or press the ESCAPE key.

Selecting Options in Dialog Boxes

Some of the options may already be set the way you want them, you can
leave them alone. Others may be sclected and changed to the way you
want them. When you are in a dialog box, one of the controls (options
or command buttons) is selected. The selected control is indicated by the
cursor. Every control in a dialog box has an emphasized letter. You
select an option or command button in one of three ways:

Basic Method. Press TAB to select the next control.
Press SHIFT+TAB to select the previous control.
Direct Method. Press ALT plus the emphasized letter
identifying the control you wish to select.
Mouse Method. Point the mouse to the desired control and click the
mouse button,

How you change an option depends on whether it is an option button,
check box, scroll bar, list box or text box.
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7.3.1 Changing a Button in an Option Box

Option buttons are organized and displayed as collections called an
option box. An option box contains buttons that may be used to set an
option. Only one of the option buttons may be set. A mark beside an
option button means that it is the selected option. An Option Button can
be set in any one of three ways:

Basic Method. Press TAB or SHIFT+TAB to select the option box.
Then press a DIRECTION key to select the desired
option button.

Direct Method. Press ALT plus the emphasized letter identifying the
option button you wish to select.

Mouse Method. Point the mouse to the desired option button and click
the mouse button.

7.3.2 Changing a Check Box Option

An X in a check box ([X]) means that the option is on. A blank in a
check box ([ ]) means that the option is not on. A check box can be set
in one of three ways:

Basic Method. Press TAB or SHIFT+TAB to select the check box.
Then press the SPACEBAR.

Direct Method. Press ALT plus the emphasized letter identifying the
check box you wish to select.

Mouse Method. Poini ihe mouse to the check box and click the mouse
button.

These actions turn the option off (if it was on) and on (if it was off).

7.3.3 Changing a Scroll Bar Option

Scroll bars are used to set options that are one of a range of possible
values. For example, the duration of the speaker beep can be expressed
as a range where one end of the range implies a very short duration, and
the other end of the range implies a relatively long duration. This type of
scroll bar option usually employs a horizontal scroll bar. The position
on the scroll bar indicates the setting of the option in the valid range of
settings. (In this case the duration of the speaker beep is approximately
one forth of the distance, indicating that the beep is to be relatively
short.)

To move the position marker left or right one position on the scroll bar,
press the LEFT or RIGHT keys. To move the position marker to the
extreme left or the extreme right, press the HOME or END keys. Refer
to "Operating Scroll Bars with the Mouse" to learn how to set scroll bar
options using the mouse.
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7.3.4 Changing a List Box Option

The name at the top of the list box tells you what the list contains. You
may select one of the items in the list. The selected item is indicated by
a highlight.

A list box may contain more items than you can see at one time. You can
scroll the list box to see other items.

To Press

Select the first item if none is selected. @DOWN

Move the selection up or down one item. UP or DOWN
Move to and select the 1st or last item. HOME or END

Move up or down in the list. PAGE UP or PAGE DOWN
Select the next item in the list that
begins with a particular letter. The letter you want.

Some list boxes are shortcuts for typing in text boxes. For example in
the dialog box for opening a file, when you select a file name from the
Files in the list box, the file name you select will automatically be copied
into the File Name text box.

Selecting in a List Box using the Mouse

All List Boxes have a vertical scroll bar. You can scroll and select an
item in a list box by following the procedure in the "Operating Scroll
Bars with the Mouse" section.

7.3.5 Changing a Text Box Option

A text box may be blank or it may contain information,

When the text box is selected, if the text box is not blank, all of the
information in the text box is selected (highlighted) and the cursor is

placed at the end of the information. You can replace the information or
edit the information to meet your needs.
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7.4 Message Boxes

Sometimes messages are displayed for you in a special kind of dialog
box. These dialog boxes contain no options, just a message and one or
more command buttons.

Some messages are informative, some are warnings, and still others are
notification of critical errors. These types of messages are displayed in
different colors on color monitors. Warning and critical messages are
accompanied with a short beep on the speaker. You can change the
colors of these windows, the pitch and duration of the beep, and even
mute the speaker entirely by changing the standard options. This is
discussed in the "Advanced Skills" section of this manual.

With some messages you are only informed of the error and are not
given any recourse as to how to proceed. For example, if you attempt to
open a file that is not found the following message will appear:

Error
C:\filename
Is not a available.

EN
|

After you have read the message, press ENTER or choose the Ok button
to continue.

Other messages ask you for direction as to how to proceed after an error
has been detected. For example, if you attempt to Save a file with
another file's name, the following message will appear:

C:\filename
Already exists?! Do you want to overwrite it?

[ Yes [I No Cancel

In this case you should answer the question by choosing the desired
command.
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7.5 Windows Menu

You may have several windows displayed simultaneously for viewing
different text. Although several windows can be open, and even visible,
only one window is "active" at a time. It is the active window that will
receive your commands.

The active window is always fully visible. Other windows may be
partially or completely hidden. The active window is indicated by a
highlighted window title. The title on inactive windows will not be
highlighted.

Any open window can become the active window. You can use the
mouse, keyboard or the Windows menu to select the window you want
to be active.

Selecting Windows with a Mouse

If any portion of the window you wish to activate is visible on the
screen, a mouse click anywhere on that window will activate it and bring
it in front of all other windows. If the window is not visible, you can size
or move the active window to make the desired window visible, or use
the mouse to select the Windows menu and choose the desired window
from the menu.

Selecting Windows with Shortcut Keys

You can use the following shortcut keys to move to the next or prior
window. The windows are sequenced in the order you opened them.
You may use these shortcut keys anytime you are in an Outline or Text
Segment Window.

To Press
Move to the Next Window Alt+Tab
Move to the Prior Window Alt+Shift+Tab

50




Selecting Windows with the Windows Menu

The Windows menu always contains a list of all open windows. You
can select any open window to be the active window by selecting the
Windows menu and choosing its name from the Windows list. The
active window will be indicated by a checkmark beside its name in the
menu. To make any of the other windows the active window, choose its
name from the menu. This will bring that window in front of all other
windows and highlight its title bar. This may hide all, or a portion of,
other windows.

More Windows

If more than nine windows are open at the same time, the Windows
menu will list only the first nine. The "More Windows" command will
be added to the bottom of the menu. You may choose any of the first
nine windows to be active. If the window you wish to make active is not
present in the list, choose the "More Windows" command. This
command will display the names of all open windows from which you
can choose the one you want.

7.6 Accessing Existing Files

When you ask to open an existing file, a dialog box will be displayed
allowing you to enter the filename or to select a filename from the list of
files available.

To Specify a File Name
When the dialog box is first displayed, the filename text box will be
highlighted. You may enter the name of the file you want. The drive

and path specifications are optional. The file you requested will be read
from disk and the outline will be displayed.
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To Select a File Name from the List

Basic Method.

1. Press the Tab key to highlight the Files list.

2. Press UP or DOWN until the name you want is highlighted.

3. Press ENTER.

If the highlight is on a filename, the file will be read and the outline
displayed.

If the highlight is on a directory entry, the list of files will be changed
to show the files available in the highlighted directory. You may
then choose one of the filenames in this new list.

JIf the highlight is on the double period (..), the list will be changed to
show the files available in the directory that is the parent of the
current directory.

Mouse Method.

Double-click on the filename you want. If necessary, use the scroll bar
to display more filenames in the list. You may also click once to
highlight the filename and then click on the Ok button.

To Qualify the Files Included in the List

When the dialog box is displayed, the Filename text box contains the
default parameter "*.txt". The list of filenames will contain only those
names that match this parameter. Therefore, only files with the extension
".1xt” will be included in the list. The default can be changed at any time
by replacing the parameter in the text box. For example, "*.DOC"
would include all files with ", DOC" as their extension.

7.7 Changing Text

At all times when you are editing text, a cursor will be displayed to show
the position in the text that will be effected by your next command. For
example as you type, the characters are placed in the text at the position
of the cursor. The cursor is either:

a blinking horizontal line (overwrite mode - This indicates that each
character you type replaces the character under the cursor.)

a blinking rectangle (insert mode - This indicates that each character
you type pushes the character under the cursor to the right by one
position.)

You change these modes by pressing the INSERT key, which will
change you to insert mode (if you are in overwrite mode) and to
overwrite mode (if you are in insert mode).




7.7.1 Text Editing Commands

Key:

RIGHT arrow ...........
LEFT arrow .............
DOWN arrow ...........
LR AW s
PAGEUP..........ccceus
PAGEDOWN............

HOME ,HOME......

Moves cursor:

.one position to right.

..one position to the left.

.to the next line.

.to the previous line.

.one window backwards.

.one window forward.

.to first character of current line.
ven.e...tO first character of window.
HOME ,HOME ,HOME.....
CTRL+HOME.......
END.,END ...............
END.END.,END ........
CTRL+END..........

.to beginning of text.
to beginning of text.

.to last character of current line.
.10 last character of window.

to end of text.

..to end of text.

CTRLA+RIGHT arrow to the next word.
CTRL+LEFT arrow...to the previous word.

CEREAET. e
CTRLA4S....cvvvee.
CTREAD ..cccinasviivania
OTRLAX . i

CTRL+W .
{38 N 1) S,
CTRLAR civivaiissivenisl
CTRLAC sunmman

BACKSPACE ..........
CTRLA+Y ..cceveenne.
ETRLEAD). .
CLREAT oo

TAB...

B [ -4 B2 (R
INSERT: ....cammeirsresi

.to the first character of the next line.

+eeee.otO the left window border.

.to the right window border.

.to the top line of window.

.to the last line of window.

.with any of the above highlights a text selection

Scrolls window contents:

.to add a new line at the top.

to add a new line at the bottom.
to place current line at top of window.

..to place current line at bottom of window.

Deletes:

..character under cursor.
.character to left of cursor.

all characters in the current line.
all characters in the current line to right of cursor.
all characters to the right of cursor to next word.

Inserts:

...spaces from cursor to next tab stop.
.carriage return at cursor position.
.carriage return at beginning of current line.

toggles INSERT and OVERSTRIKE modes.
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CTRL+INSERT........
SHIFT+DELETE......
SHIFT+INSERT........

AIELEESS, o,
ALTHRI0 cocoioverssnsns=s

7.7.3 The Clipboard

The Clipboard is a temporary holding area for information. You put
information into the Clipboard using the Cut and Copy commands. You
get information from the Clipboard using the Paste command. The
the clipboard are available on the Edit menu.

commands that affect

7.7.4 Text Selection

Clipboard:

.Copy selection to clipboard
.Cut selection to clipboard

Delete selection
Paste selection from clipboard

When editing text in Lesson Editor:
Close the text window

....Restore the text window size
...Move the text window

.Size the text window
.Maximize the text window

You “select” text in order to perform operations such as:

Deleting a block of text.

Replacing a block of text with a character from the keyboard or the

clipboard.
Moving a block of

text from one location to another by the Cut and

Paste commands.

Copying a block of text to another location using the Copy command.

Writing a block of text to a file.
Printing a block of text.

"Selected” text is differentiated from the rest of your text by being
displayed as highlighted. You can select text using either the keyboard

or the mouse.
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Selecting Text using the Keyboard
To select text using the keyboard, perform the following:

1. Move the cursor to the first character you wish to select using the
DIRECTION keys.

2. Press the SHIFT key and hold it down while you press the
appropriate DIRECTION keys to move the cursor to the immediate
right of the last character you wish to select. For example,
SHIFT+RIGHT moves the cursor to the right and selects the
character the cursor was under. Continuing to hold the SHIFT key
down and pressing the RIGHT key "extends" the selection to the
right. .

SHIFT+END will select (or extend the current selection to) all characters
from the cursor position to the end of the line. SHIFT+DOWN will select
(or extend the selection to) all characters remaining in the line including
the cursor position and those to the left of the cursor in the next line
below it. SHIFT+PAGE DOWN will select (or extend) the next full
window of characters. SHIFT+CONTROL+END will select (or extend)
all characters from the cursor location to the end of the file.

Selecting Text using the Mouse
To select text using the Mouse, perform the following:

1. Point the mouse cursor to the first character you wish to select and
press the mouse button.

2. Drag the mouse over the selection.

3. Release the mouse button.

If not all of the text you wish to select is visible, you can scroll the text
and extend your selection by dragging the mouse pointer to the upper or
lower, left or right window border and holding it there. The text will
continue to scroll in the specified direction, and be selected until you
drag the mouse pointer back into the window. You may also select a
large portion of text by:

1. Point the mouse to the first character you wish to select. Hold down
on the shift key and press the mouse button.

2. Position the cursor past the last character you wish to select.

3. Click the mouse button.
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Chapter 8 Advanced Skills

8.1 Control Menu
The symbol in the upper left corner of the window is called the "Control
Menu Box". The Control Menu provides commands which allow you to

Move, Size or Close windows.

r— Restore Box

Control
Menu Box —» =—Uindow Title Bar——» <{— Maximize Box
> E
Restore Alt+FS i
Move Alt+F7
Control Size Alt+F8
Henu MHaximize Alt+Fi18
Close Alt+F4

n
I A ¢— Sizing Box

To Select the Control Menu
Using the keyboard: press ALT, SPACEBAR.
Using the mouse: point the mouse to the Control Menu Box and
click.

8.1.1 Restore Command
The Restore command will restore the window to its size before it was
maximized. To Restore a Window:

Using the keyboard. press ALT, SPACEBAR to select the Control
Menu. Then choose the Restore command.

Using the mouse. point the mouse to the Restore Box («) and
click.

8.1.2 Maximize Command

The Maximize command will expand the active window to fill the entire
desktop. You may use this command to enlarge a window to its
maximum size, then use the Restore command to return the window to
its original size. To Maximize a Window:

Using the keyboard: press ALT, SPACEBAR to select the Control
Menu. Then choose the Maximize command.

Using the mouse:  point a mouse to the Maximize Box (») and
click.
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8.1.3 Move Command

If the active window is small, the Move command allows you to move
the window on the screen. This is sometimes desirable in order to
"uncover” other hidden windows and bring their contents into view
while leaving the active window on top. To Move a Window:

Using the keyboard:

1. Press ALT, SPACEBAR to select the Control Menu.

2. Choose the Move command. A heavy border will appear around the
window. This heavy border will move to guide you in selecting a
new location for the window.

3. Press the DIRECTION key (LEFT, RIGHT, UP, DOWN) for the
direction you want to move the window. As you press the
DIRECTION keys, the heavy border will move to the new location.

4. When you have positioned the window in the location you want,
press ENTER. The window will be moved to that location.

Note: The Move command will not change the size of a window. You
may also wish to use the Size command to change the window's size.

Using the mouse.
1. Point the mouse to the Title Bar.
2. Press the Mouse button. A heavy border will appear.
3. Drag the mouse until the heavy border is positioned where you want
the window to be placed.
4. Release the mouse button.
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8.1.4 Size Command
The Size command allows you to enlarge or decrease the height/width of
a window. To Size a Window:

Using the keyboard:

1. Press ALT, SPACEBAR to select the Control Menu.

2. Choose the Size command. A heavy border will appear around the
window. This heavy border will shrink/expand to guide you in
selecting a new size for the window.

3. Use the DIRECTION keys to change the size of the window.

LEFT decreases the width of the window. The minimum window
width is four (4) characters.

RIGHT increases the width of the window. You cannot expand the
window width past the rightmost screen position. You may
wish to use the Move command to move the window to the
left, and then choose the Size command again to expand it
more to the right and make more of the contents visible.

UP decreases the height of the window. The minimum height of
a window is 3 lines.

DOWN increases the height of the window. You may wish to use
the Move command to move the window up, and then
choose the Size command again to expand it more.

4. When the heavy border shows a size you want, press ENTER. The
window will be changed to the size you have set.

Using the mouse:
1. Point the mouse to the Sizing Box (lower right corner of the
window). Press the mouse button. The heavy border will appear.
2. Drag the mouse until the heavy border is the size you want.
3. Release the mouse button.

If you size a window, the text is automatically reformatted for display in
the new window size.

8.1.5 Close Command
The Close command will close the active window and remove it from the
screen.

58




8.2 Customizing

The System Control Menu (the symbol in the upper left corner of your
screen) provides commands which allow you to customize for your
computer configuration and personal preference. To access the System
Control Menu:

Using the keyboard: press the ALT,SHIFT+SPACEBAR keys.
Using the mouse: click the mouse on the System Control Menu Box.

Settings Command

The default configuration settings can be changed through the Settings
command. The options include:

Mouse Options for double-click speed, acceleration.
Speaker Options for the pitch, duration, and muting.
Printer Options for port selection, manual page feed.
Window Color Options for each window type.
Palette Options for fine tuning of colors.

File Path Options for each file type.

The Settings command displays a dialog box. Select the option you want
to change, change the option, and choose a command button. The Cancel
button will ignore any changes you have made and restore the Settings to
their previous values. The Ok button will record your settings
permanently for this and future sessions.

Double Click Option

When you click the mouse button twice, the time interval between the
clicks determines whether a double click or two single clicks are
recognized. If the time interval is less than the Double Click value, the
two clicks will be recognized as a double click command. If the time
interval is greater than the double click value, the clicks will be
recognized as two single clicks. You may set this speed to your own
preference and mouse dexterity. The button labeled "Test” can be used
to help you in arriving at an appropriate setting. After you have set the
Double Click speed you want to try, double click on the Test button.
The button will light up when a double click has been recognized.
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Acceleration Option

Acceleration refers to how responsive the mouse is to your hand
movements. SLOW implies the mouse moves slowly, so moving the
mouse a long distance on the table will move the mouse pointer only a
short distance on the screen. FAST implies the mouse moves quickly, so
moving the mouse a short distance on the table will move the mouse
pointer a longer distance on the screen.

You may wish to choose a slower speed if you are relatively new to
using a mouse. With a slower speed, you have greater control of the
precise position of the mouse. The disadvantage of SLOW acceleration is
that you must have a comparably larger surface area for your mouse in
order to move it to all portions of the screen without having to lift and
reposition it.

Swap Buttons Option

The Swap buttons check box allows you to tell that you prefer pressing
the right mouse button rather than the left button. You may find this
particularly useful if you are left handed.

Duration, Pitch Options

Duration refers to the length of time the speaker will make noise when
beeps inform you of an error. Pitch is the type of sound it will make.
The "Speaker Test" button allows you to test your settings. Choose the
Speaker Test button, and the speaker will sound with your new settings.

Mute Option
You can silence the beep by checking this option.

Prevent CGA Snow
Some Color Graphics Adaptors (CGA) produce "snow" on the screen.
You can make screen writing slower and eliminate the "snow" by
selecting this option.

Autosave Files Option

The Autosave option instructs the program to save any modifications te
the Lesson Editor text windows automatically. If this option is set off,
when you modify text and then close the window, you will be asked
whether to save the modifications or not. If this option is set on, the
modified data will be saved automatically. This option should usually be
left on.

There may be times when you modify text and then change your mind.
To avoid saving the modifications, turn Autosave off, close the window
containing the modified text, answer no when asked whether to save the
modifications, then turn Autosave back on.
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8.2.1.1 FILES Button

Select the Files button to set the path for each file type. Each file type is
listed with its path name. You may set each path as you prefer. Any valid
path will be accepted. Examples:

£
C:\BIBLE\
\BIBLE\
C:\BIBLE\KJVTEXT\

8.2.1.2 Printer Setup Button
The Printer Setup is described in the chapter on Printing.

8.2.1.3 WINDOW Button

The Window button allows you to select for each type of window one of
the following color palettes:

RED WHITE BLUE YELLOW  MONOCHROME
CYAN GREEN BLACK MAGENTA
Window List

The Window list shows all of the types of windows. For example, the
list includes:

Bible text used to display scripture text

Verse List used to display verse references

QOutline used for Chronological Bible

Editor used for Lesson Editor

Dialog Boxes used for other asking you for instructions

used also for other Add-on products

When you select a window type, the Palette list will highlight the palette
currently selected for that type of window. The "Sample” window will
show how that palette looks on your screen. You can review the color
palettes assigned to all window types by choosing, in succession, each of
the entries in the Window list.

If you decide to change the palette assignment of a window type, choose
the window you want to change from the Window list and then choose a
new Palette from the Palette list.

Expanded Colors Option

If this option is off, you may choose one of 8 possible background colors
or one of 8 more background cclors that flash. If this option is on (and
your color monitor supports the capability) you may choose one of 16
background colors.
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Palette List

The Palette list shows the Palettes available. A Palette is a set of
background and foreground color combinations. For example, the
WHITE palette paints the background white and uses various
background and foreground color combinations to display the different
types of information in the white window. As you choose palettes, the
"Sample” window on the right is repainted to show the color
combinations currently assigned to that palette.

When you choose a palette from the list, all windows of that type will
use the selected palette. When you select the Ok button, your screen will
be changed to reflect your color selection. If you choose the Cancel
button, current assignments for window colors will remain.

8.2.1.4 PALETTES Button

A color palette is a set of colors used to display a window. Different
color monitors display colors differently. The Palettes command allows
you to "fine tune" the color selection of a given palette. You can change
any foreground and background colors for any information for any
palettes. While this is possible, you will probably only want to change
the color combinations which are difficult to read on your monitor.

Palette List
The Palette List shows the different color palettes available. This is the
same list that appears in the Window colors dialog box described above.

Attribute List
The Attribute list contains a descriptive name of each different type of
information that can occur in a window. Each uses a different color.

Protected data is only for display and cannot be changed
Choices dialog boxes offer choices to select from
Emphasized data is highlighted for emphasis

Mnemonics shows letter used for keyboard selection
Unavailable shows choices not currently available
Selected shows data that has been selected

In addition, menus and commands are displayed in different colors.

Action Bar a menu bar or a menu

Action Choice a menu or command that is available
Action Mnemonics letter used for keyboard input
Action Selected shows which action is selected
Action Disabled shows action® not available

You can change any foreground and background colors for any
information for any palettes that are difficult to read on your monitor.
As you change the colors, the sample window will show how that
information will appear on your screen.
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Background Option

This Scroll Bar option is displayed immediately below a "color chart”
which shows you the background colors available. You choose a
background color by moving the scroll bar position directly under the
color in the color chart that you want. "Background" refers to the color
of the screen directly behind the character being displayed.

Foreground Option

This Scroll Bar option is displayed immediately below a "color chart"
which shows you the foreground colors available for the currently
chosen background. You choose a foreground color by moving the
scroll bar position directly under the color in the color chart that you
want. "Foreground" refers to the color of the character itself.

Changing the Color of an Attribute
Follow these steps to change the colors used to display an attribute.

1. Choose a Palette.

As you choose each palette in succession, the "Sample"” window to the
right displays an example of a screen written using all of the attributes
assigned to that palette. You can easily see which are easy and which are
difficult to read. The words used in the Sample screen are written in the
colors corresponding to the attributes they describe. For example,
"Protected Information" is written using the colors of the attribute called
"Protected".

2. Choose an Attribute.

As you choose each attribute in succession, the Background Option will
be set to the position corresponding to the current setting of the
attribute’s background color. Additionally, the color chart for the
Foreground option will be displayed using this background color, and
the Foreground Option will be set to the position corresponding to the
attribute's foreground color.

You may now choose a Background color for the attribute, or leave the
background alone and change only the Foreground color. To change
either Background or Foreground:

3. Select the option and choose the position you want. As you choose
positions on the scroll bar, the "Sample” window will be changed to
illustrate your choice.
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APPENDIX A
Using the VERSE TYPIST Product

This section is included for users who have the VERSE TYPIST product
installed.

In this documentation, THE WORD processor' refers to the Bible study
program available from Bible Research Systems; and 'word processor'
refers to any generalized word processing product that you use to write
documents.

The VERSE TYPIST is a memory resident program (often referred to as
a TSR - Terminate and Stay Resident). There are several new terms and
steps to follow that may be unfamiliar to you. On the next few pages
you will find detailed instructions for each of the following steps:

Step 1 - Install the VERSE TYPIST
Copy the files on the VERSE TYPIST disk to the same subdirectory
where VERSE SEARCH is installed.

Step 2 - Initiating the VERSE TYPIST

Run the VERSE TYPIST program. You do this once every time your
computer is turned on. It is usually done by adding a command to your
Autoexec.Bat file so the VERSE TYPIST will always be available.
Identify one of the keys on your keyboard to be a 'hotkey' that will
activate the VERSE TYPIST (the default is the ALT+V key).

Step 3 - Start your word processor
Use your word processor to prepare a lesson. Position the cursor to a
point in your lesson where you want a verse typed.

Step 4 - Activate the VERSE TYPIST

Press the hotkey. A small window will appear in the center of your word
processor page. By selecting commands from this window you may
browse through the Bible text and display any reference.

Step 5 - Transfer Bible text into your lesson

Select the Transfer command. The text you selected will be copied into
your document just as if you had typed it yourself.
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Installing VERSE TYPIST
1. Place the VERSE TYPIST disk in Drive A.
2. Enter the command A:INSTALL
3. Set the "Copy from" and "Copy to"
4. The files will be copied to your hard disk.

Initiating the VERSE TYPIST

You may initiate the VERSE TYPIST as a memory resident program at
any time. Usually, you would add the necessary commands to your
Autoexec.Bat file. The -VERSE TYPIST program would then be
available to use at any time. First, you MUST set the subdirectory
where the VERSE TYPIST is installed to be the current directory. For
example, enter the change directory command:

CD\BIBLE
Thenenter: TYPIST

The VERSE TYPIST program will be initiated and ready to use.

NOTE: There is a file called README on the VERSE TYPIST disk that
contains specific instructions (such as the appropriate delay factor) for
each word processor we have tested. The README file is in standard
ASCII format. Use your word processor (or the TYPE README
command) to read or print this file. The VERSE TYPIST disk also
contains a second program called TYPISTX. If the TYPIST program
does not work well with your word processor, use TYPISTX instead.
Both TYPIST and TYPISTX have the same functionality.
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Instructions for Activating

You may activate the VERSE TYPIST program to type a verse at any
time by pressing the V key while holding the ALT key. The ALT+V key
is called a 'hotkey'. You may use it at anytime, even when other
programs are running.  Usually, you will begin using your word
processor to compose a lesson. When you reach a point where you
would like to have a verse inserted, just press the ALT+V key. A HELP
screen will initially be displayed showing the commands available. The
following prompt line will be displayed.

Goto Transfer Range Options Library ESCape

Select the Goto command (press the G key) to display any verse in the
Bible.

Press the UP arrow key to display the previous verse in the Bible text.
Press the DOWN arrow key to display the next verse in the Bible text.

Select the Transfer command (press the T key) to transfer the displayed
verse to your word processing document.

Select the Range command (press the R key) to transfer many verses at
one time. You will be asked to enter a beginning and ending verse
reference. All the verses you request will be transferred. You may stop
the transfer at any time by pressing the ESCAPE key.

Select the Library command (press the L key) to work with verses from
a Verse List.

Select Option (press the O key) to set the control options for the VERSE
TYPIST. The new control options will automatically be saved if the
VERSE TYPIST disk has room and is not write protected.

Press the ESCAPE key at any time to stop a range transfer or to return to
your word processor.
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Transferring a Verse

Start your word processor and begin typing a lesson. Move the cursor to
any position in your lesson where you want a verse typed and then:

Set the INSERT key 'ON' If the INSERT key is 'ON' the verse will
be inserted into your lesson at the position of
your cursor. If the INSERT key is 'OFF, the
verse will overlay whatever was in your lesson
at that point.

Press ALT+V This activates the VERSE TYPIST and
displays a small window on the screen.

Press the G key Go to any verse reference in the Bible.

Type JOH 3:16 Press the ENTER key and the verse will be
displayed.

Press the T key Watch the verse appear in your document
exactly as if you had typed it in yourself.

When you are using the VERSE TYPIST with either the HEBREW or
GREEK transliterators, only the Bible text will be transferred. (Strong's
reference numbers are not transferred.) Press the ESCAPE key at any
time to return to your word processor.

Transferring a Range of Text

If you want a range of verses transferred into your document, select the
Range command. You will be asked to enter the exact range of verses
you want. Most forms of verse references will be accepted such as:

GEN GEN 1:1 GEN 1:1 - EXO 2:5
GEN 1 GEN 1:1-5 GEN 30 -EXO2
GEN1-2 GEN1:1-2:5 GEN3:1-EXO2

All verses within the range you specify will be transferred to your

document. You may stop the transfer at any time by pressing the
ESCAPE key.
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Transferring Verses from a Verse List

You may transfer the text from verses found in any Verse List. When
you select the Library command (press the L key), the path and Verse
List name specified in OPTIONS will be displayed. If this is the Verse
List you want, just press ENTER and the first verse in the Verse List (or
the one you last displayed) will be displayed. If you wish a different
Verse List, enter the name (the path can only be changed on the
OPTIONS screen) and press ENTER. The window will contain the
following prompt line:

Previous  Next  First Last Transfer All ESCape

The current reference position and the total number of references in the
list will be displayed at the bottom of the VERSE TYPIST window.

The UP arrow key will display the previous verse in the Bible text.
The DOWN arrow key will display the next verse in the Bible text.

Select the Previous command (press the P key) to display the previous
verse in the Index.

Select the Next command (press the N key) to display the next verse in
the Index.

Select the First command (press the F key) to display the first verse in
the Index.

Select the Last command (press the L key) to display the last verse in the
Index.

Select the Transfer command (press the T key) to transfer the verse
displayed to your word processing document.

Select the All command (press the A key) to transfer all the verses
beginning with the one displayed and continue transferring all index
verses until the end of the Index. Only the first 1020 verses in each
index can be displayed or transferred. At any time by pressing the
ESCAPE key you may stop the transfer or return to the text display
window.
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Setting Your Options

The Options screen allows you to:
- select the desired Bible translation
- transfer the verse with
a full reference (book chapter:verse)
or a partial reference (verse number only)
or no reference (in paragraph form)
- transfer between each verse
a full break (a blank line)
or a partial break  (start a new line)
or no break (in paragraph form)
- change colors / attributes
- change location of the window on the screen
- automatically advance to next verse after each transfer (Yes/No)
- change the path where the Bible text files can be found
- change the path and the name of the Verse List file
- change the delay factor for your word processor

Use the UP/DOWN arrow keys to choose which option you want to
change. Use the LEFT/RIGHT arrow keys to change that option.

The Delay Factor

Each word processor is different in the way it accepts input from the
keyboard. Timing is very important. The VERSE TYPIST must be
ready to transfer a character of text just at the proper time that your word
processor is waiting for a character of text. There is no single method
that works for all word processors. Therefore, we have included an
option called the Delay Factor. You may select the delay that works best
for your word processor. The README file has the recommended delay
factor for each word processor we have tested. If you have problems, try
increasing the delay factor using these steps:

- press the hotkey to activate the VERSE TYPIST

- press the letter O key to set options

- press the DOWN arrow key to move the arrow

to the line labeled, DELAY FACTOR:
- press the RIGHT arrow key to increase the delay Gl

Continue testing using a higher delay with your word processor. If
problems continue, please call and tell us which word processor you are
using. If it doesn't work the first time you try, call us and we will help
you.
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Changing the Hotkey

To change the hotkey to something other than ALT+V, append the
mumber of your choice to the command that initiates the VERSE
TYPIST. For example, to set ALT+X as the hotkey, enter the command:

Even after the VERSE TYPIST has been initiated you may change the
hotkey by entering the TYPIST command again with a new number.
You may choose to use a function key as a hotkey by itself or with the
SHIFT, CTRL, or ALT key held down. The possible hotkey numbers

TYPIST 45

are listed in the following tables.

For a function key:

For a letter key with Alt key: By  With With With
Itself Shift Ctrl Alt
Hot Use Hot Use Hot Use Use Use Use
Key # Key # Key # # # #
AltA 30 AltU 22 F1 59 84 94 104
AltB 48 AltV 47 F2 60 85 95 105
AltC 46 Alt'W 17 F3 61 86 96 106
AltD 32 AltX 45 F4 62 87 97 107
AltE 18 AltY 21 F5 63 88 98 108
AltF 33 AltZ 44 F6 64 89 99 109
AltG 34 2 65 90 100 110
AltH 35 AltTab 15 F8 66 01 101 111
Altl 23 Altl 120 F9 67 92 102 112
Alt] 36 Alt2 121 F10 68 93 103 113
AltK 37 Alt3 122
AltL 38 Alt4 123 Note:
AltM 50 Alt5 124 To avoid using the Alt key,
AltN 49 Alt6 125  set Cirl 2 as the hotkey by
AltQ 24 Alt7 126  using the command: TYPIST 3
AltP 25 Alt8 127
AltQ 16 Alt9 128
AltR 19 Alt0 129
AltS 31 Alt- 130
AT 20 Alt=_ 131
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Appendix B
Using the Librarian Product

This section is included for users who have the Librarian product
installed.

Product Description

Librarian is a powerful tool for creating a library of Bible research
materials. The information you collect over many years of Bible study
can be permanently stored on your computer for cross reference and
review. As you use the Librarian more and more, your library of study
resources will grow larger and more comprehensive.

Installing Librarian
1. Insert the LIBRARIAN disk in drive A,
2. Type the command: A:INSTALL
3. Set the "Copy From" and "Copy To"
4. The files will be copied to your hard disk.

B.1 Librarian Command

The Librarian command on the StudyAids menu displays the Verse List
window and displays a new menu bar with commands for saving,
loading, sorting and merging any Verse List from your library.

B.1.1 Load a Verse List

. The Load a Verse List command allows you to select any Verse List
from any library. When you choose the Load a Verse List command, a
list of the Verse Lists currently in the library is displayed. You may pick
any name from this list or you may enter the path for a different library
of Verse Lists. When you select a file name, that Verse List will be read
and displayed.

B.1.2 Save a Verse List

The Save a Verse List command allows you to save the Verse List
currently displayed. When you enter a file name, the Verse List will be
written on the disk in the directory you specified. A Verse List name is
used to create a file, so the name must follow the rules for valid file
names for your computer. The name can contain a maximum of 8 letters
or numbers. An optional disk drive or path specification is allowed.

The Verse List in memory is constantly changing. Every search changes
the Verse List. You can save the Verse List at any time using the Save a
Verse List command. The Verse List is never saved automatically. If
you do not save it, the Verse List is changed by the next search request.
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B.1.3 Remove a Verse List

The Remove a Verse List command allows you to get rid of any Verse
List in the library you no longer need. When you select a file name, that
Verse List will be deleted.

B.1.4 Description

The Description command allows you to add a description to any Verse
List in any library. You may enter any information that helps you
remember how, when and why you created that Verse List. The
description can be displayed and changed at any time. The name of the
Verse List is displayed as the title of the window. Enter any text and
select the Ok button. If you change your mind, select the Cancel button,
A Verse List can have a description saved with it only if the Verse List
has been saved on the library (see the Save a Verse List command).

B.1.5 Empty Verse List

The Empty Verse List command will delete all verses from the Verse
List. An empty Verse List cannot be saved into the library. If you want
to remove a Verse List from the library, use the Remove a Verse List
command.

B.1.6 Sort Verse List
The Sort Verse List command allows you to choose:
Sort the Verse List.
The verses will be kept in the same sequence as the Bible. Inserts
will be added in their proper position. Duplicates will be ignored.
Unsort the Verse List.
You may choose the sequence of verses. Inserts will be added
after the verse highlighted in the list. Duplicates will be allowed.

B.1.7 Merge a Verse List

The Merge a Verse List command allows you to select any Verse List
from any library to be merged with the Verse List currently displayed.
When you select a file name, the Verse List will be read from the library
and merged. A merged Verse List will be sorted in the same sequence as
the Bible. You may choose to merge two Verse Lists as a:
Combination:

All verses from either Verse List will be combined into a new Verse List.
Duplicates will be ignored. For example: you may want to combine a
Verse List on salvation with a Verse List on forgiveness to create a new
Verse List with all verses from either subject.

Intersection:

Only verses common to both Verse Lists will be kept. For example: you
may want to find the intersection of a Verse List on end-times prophecy
with another Verse List on judgment to create a new list of verses that
deal with both subjects.
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B.2 Lesson Editor Command

The Lesson Editor command displays a window for you to enter the text
of your lesson. A new menu bar will be displayed allowing you to save
your lesson text in the library and to load previous lessons from the
library. You can edit the lesson text and copy verses from the Bible into
your lesson.

B.2.1 Editor File Menu

B.2.1.1 Editor Load Command

To load an existing file, select the File menu and choose the Load
command. A dialog box will be displayed. The filename text box will
be highlighted. You may enter the name of the file you want. The drive
and path names are optional. The file you requested will be read from
disk and displayed.

To Select a File Name from the List
Using the keyboard:
1. Press the TAB key to highlight the Files list.
2. Press UP or DOWN until the name you want is highlighted.
3. Press ENTER.
.If the highlight is on a filename, the file will be read and displayed.
JIf the highlight is on a directory entry, the list of files will be changed
to show the files available in the highlighted directory. You may
then choose one of the files in this new list.
If the highlight is on the double period (..), the list will be changed to
show the files available in the directory that is the parent of the
current directory.

Using the mouse.

Double-click on the filename you want. If necessary, use the scroll bar
to display more filenames in the list. You may also click once to
highlight the filename and then click on the Ok button.

To Qualify the Files Included in the List

When the dialog box is displayed, the Filename text box contains the
default parameter "*.txt". The list of filenames will contain only those
names that match this parameter. Therefore, only files with the extension
" txt" will be included in the list. The default can be changed at any time
by replacing the parameter in the text box. For example, "*.DOC"
would include all files with ".DOC" as their extension.
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B.2.1.2 Editor Save Command

The Save command on the File menu asks you to enter the name you
want to use for a file. The text will be written to the file you specify. If a
file already exists with that name, you will be asked if it is ok to write
over it.

B.2.1.3 Editor Close Command

The Close command on the File menu closes the active window. If the
Autosave option is on, any changes that have been made to the text will
be saved on disk. The text window will be removed from the screen. If
the Autosave option is off and changes have been made to the text, you
will be asked whether to save the changes. If you respond Yes, the
changes will be saved. If you respond No, the changes will be ignored.

B.2.1.4 Editor Merge Command

The Merge command on the File menu displays a list of names of files.
When you select a file name, the text in that file will be copied into the
text currently displayed at the location of the cursor.

B.2.1.5 Editor Print Command
The Print command on the File menu prints the text or a highlighted
selection of the text.
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B.2.2 Editor Edit Menu

The Lesson Editor Edit menu provides commands to cut, copy and paste
text or to copy verses into the lesson text.

B.2.2.1 Editor Cut Command

The Cut command on the Edit menu copies the selected text to the
clipboard and deletes the selected text from the window. The deleted text
ic available in the clipboard io be pasted to another location in the
window. The Cut command requires that some portion of the text be
selected.

B.2.2.2 Editor Copy Command

The Copy command on the Edit menu copies the selected text to the
clipboard. The text is available in the clipboard to be pasted to another
location in the window. The Copy command requires that some portion
of the text be selected (highlighted).

B.2.2.3 Editor Paste Command

The Paste command on the Edit menu copies the clipboard to the text
window at the position of the cursor. The text continues to be available
in the clipboard to be pasted to another location in the window.

B.2.2.4 Editor Clear Command

The Clear command on the Edit menu deletes the selected text from the
window. The text is NOT copied to the clipboard. The Clear command
requires that some portion of the text be selected (highlighted).

B.2.2.5 Editor Copy Verse Command

The Copy Verse command copies the verse last shown in the scripture
window into the text of your lesson. The verse will be copied at the
location of the cursor. Only 1 verse will be copied.

B.2.2.6 Editor Copy Range Command

The Copy Range command copies a range of verses. You will be asked
for the range you want. Those verses will be copied into your lesson text
at the location of the cursor. A maximum of 100 verses can be copied at
one time.

B.2.2.7 Editor Copy Verse List Command

The Copy Verse List command copies the text of the verses from the
Verse List into your lesson text. The verses will be added at the location
of the cursor. A maximum of 100 verses can be copied at one time,
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B.2.3 Editor Search Menu

The Lesson Editor Search menu provides commands to:
find anything in the text,
change anything in the text,
find next occurrence.

B.2.3.1 Editor Find Command

The Find command on the Search menu finds anything in the text.
Select the Find command, enter what you want to locate and the text you
requested will be displayed.

B.2.3.2 Editor Change Command
The Change command on the Search menu finds every occurrence of the
text you request and changes it to the new text you specify. You may
enter the text you want to find and the text you want to replace it with. If
you choose the Change All button, every occurrence of the text will be
found and changed. If you choose the Find and Verify button, each time
the text you requested is found, the text will be highlighted and you will
be asked to verify if you want this particular occurrence to be changed.
You can respond:

Yes, and the change will be made;

No, and the change will not be made;

Cancel, to stop the search.

B.2.3.3 Editor Find Next Command

The Find Next command on the Search menu finds the next occurrence
of the text you requested. The Find command must be used first to
specify what text you want to find and to find the first occurrence. Then
the Find Next command can be used to find the following occurrence of
the requested text.
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Appendix C
Using the TOPICS Product

This section is included for those users who have the TOPICS product
installed. TOPICS requires the LIBRARIAN product.

PRODUCT DESCRIPTION

TOPICS is a topical Bible. It is a collection of Verse Lists created using
LIBRARIAN that cross reference the Bible by subject. Verse Lists are
included for over 200 of the most significant topics discussed within the
Bible. The topical lists allow you to display or print the verses of the
Bible that deal with a common topic.

INSTALLING TOPICS

1. Insert the TOPICS disk in drive A.

2. Type the command: A:INSTALL

3. Set the "Copy From" and "Copy To"

4. The directory called TOPICS will be copied to your hard disk.

DISPLAYING TOPICS
Select the LIBRARIAN memn and choose the Load A Verse List
command. Select the directory called TOPICS. This will provide a list

of the names available in TOPICS. Choose any name from the following
list you wish to display.

77




.. EMPLOYEE/EMPLOYER
.. EUCHARIST
.EVANGELISM

APOSTASY ... EXCUSES

ASSURANC........ .... FAITH IN CHRIST
ASTRONOM .. .FAITH IN GOD
ATHEISM........... .... FALSE DOCTRINE
ATONEMEN .... FAMILY
BAPTISMI .. .FASTING

... FEAR OF GOD
FELLOWSHIP-BELIEVERS
... FELLOWSHIP WITH CHRIST
+ues FELLOWSHIP WITH GOD
+es FINANCES

.FORGIVEN
. FRIENDSHIP
.FRUITS OF RIGHTEOUSNESS
.FRUITS OF SIN

... GOD THE CREATOR
... GOD THE FATHER
.GOD'S GLORY
...GOD'S KNOWLEDGE

CHURCH2...... :
..GOD'S LOVE

COMMANDI . COMMANDMENTS-EPISTLES .GOD'S MERCY
COMMAND?2 . COMMANDMENTS-CHRIST .GOD'S POWER
COMMUNIO.. COMMUNION WITH GOD .GOD'S PROVISION
CONFESSI.. CONFESSION OF CHRIST .GOSPEL

CONSCIEN.,
CONSOLAT

.GOSSIP
.GRACE
.HEART
.HEAVEN
.HELL
.HOLINESS
.HOLY SPIRIT

HOMOSEXU.... HOMOSEXUALITY
HOFPE................ HOPE
HUMILITY...... HUMILITY
HUSBANDS..... HUSBANDS
HYPOCRIS....... HYPOCRISY

IDOLATRY
IGNORANCE
IMMORTALITY

... IMPENITENCE
INCEST
INFIDELITY TO GOD
... INSPIRATION
INTEGRITY
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..JESUS' OBEDIENCE

s X
e JUDGMENT

JUSTIFICATION

-PRIDE
..PROPHECIES ABOUT JESUS
..PROPHECIES BY JESUS

REGENERA. ... REGENERATION

RELIGION........ RELI GION
REPENTAN...... REPEN TANCE
REPROBAC.... REPROBACY
REPROOF ........REPROOF
RESIGNAT....... RESIGNATION
RESPONSI ......RESPONSIBILITY
RESURREC...... RESURRECTION
REWARD........REWARD
RICHES...........RICHES
RIGHTEOU ...... RIGHTEOUSNESS
SABBATH........SABBAT
SALVATI! ....... SALVATION&WORKS
SALVATIZ .....SALVATION
SANCTIF
SATAN......
SCOFFING
SECOND
SELF1....
SELF.....
SERVANTH..... SERVANTHOOD
11 [ . i |
SPEECH ...........SPEECH
SPIRITI. ... SPIRIT OF MAN
SPIRITZ........... SPIRITUAL ADOPTION
SPIRIT3 ... SPIRITUAL BLESSINGS
SPIRIT4. ...3PIRITUAL BLINDNESS
SPIRITS............SPIRITUAL DEATH
SPIRITS............ SPIRITUAL DESIRE
SPIRIT7 .. SPIRITUAL GIFTS
STRIFE.. STRIFE
SUFFERIN SUFFERING
SYMBOLS ......SYMBOLS
TEMFTATI ...... TEMPTATIONS
TESTIMON ...... TESTIMONY
THANKFUL..... THANKFULNESS

.« TRINITY

UNBELIEF

VOWS.......ccoo.... YOWS
WATCHFUL .... WATCH FULNESS
WICKED........... WICKED

WORLDLINESS

WORLDLY CARES
WORSHIP ....... WORSHIP
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Appendix D
Using the PEOPLE Product

This section is included for those users who have the PEOPLE product
installed. PEOPLE requires the LIBRARIAN product.

PRODUCT DESCRIPTION

PEOPLE is a collection of Verse Lists created using LIBRARIAN that
cross reference the Bible by characters. Verse Lists are included for over
140 of the most significant people discussed within the Bible. The Verse
Lists allow you to display or print the verses of the Bible that deal with a
common topic.

INSTALLING PEOPLE

1. Insert the PEOPLE disk in drive A.

2. Type the command: A:INSTALL

3. Set the "Copy From" and "Copy To"

4. The directory called PEOPLE will be copied to your hard disk.

DISPLAYING PEOPLE

Select the LIBRARIAN menu and choose the Load a Verse List
command, Select the directory called PEOPLE. This will provide a list
of the names available in PEOPLE. Choose any name from the
following list you wish to display.
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JESUS' COMPASSION

... JESUS' DEATH

... JESUS' DIVINITY
JESUS' HUMANITY

BATHSHEB.............. ... JESUS' KINGSHIP

BOAZ........... .. JESUS' MISSION
CAIAPHAS.. JESUS' OBEDIENCE
CALEB..... ... JOAB

JOASH

. JOB

... JOHANAN

JOHN THE BAFPTIST
.JOHN THE APOSTLE

CYRUS.
DANIEL...

ONAH... JONAH

JONATHALI ...... JONATHAN THE LEVITE
JONATHAZ......JONATHAN, SON OF SAUL
JORAM............. JORAM
JOSEPH]1..........JOSEPH, SON OF JACOB

e JOSHUA
... JOSIAH
JOTHAM
.. JUDAH
... JUDAS ISCARIOT
.LABAN
.. LAZARUS
... LEAH
.LOT
.LUKE
.MAHLAH
.MANASSEH
.MARK

HEROD THE KING
HERCD TETRARCE
... HEZEKTAH
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JOSEPH, MARY'S HUSEAND
.JOSEPH, BURIED JESUS




DESCRIPTION

~.MARY, JESUS' MOTHER
..MARY MAGDALENE
..MARY, SISTER OF LAZARUS
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Appendix E
Using the Personal Commentary Product

This section is included for those users who have installed the
PERSONAL COMMENTARY product.

Product Description

The purpose of the PERSONAL COMMENTARY product is to allow
you to associate your own personal commentary with each Bible verse.
When you are displaying Bible text, you choose the Personal
Commentary command. The screen will be divided into two windows.
The top window will contain the text of the verse. The bottom window
will contain the commentary associated with that verse. If you have not
previously associated commentary with that verse, the bottom window
will be blank. The cursor will be positioned to allow you to create or
edit the commentary. Your comments will become a permanent addition
to your library. Any time you refer to this verse, your comments will be
available, even if you are studying a different translation.

Installing Personal Commentary

1. Insert the PERSONAL COMMENTARY disk in drive A.
2. Type the command: A:INSTALL

3. Set the "Copy From" and "Copy To"

4. The files will be copied to your hard disk.

Displaying your Commentary

The Personal Commentary command on the StudyAids menu displays a
verse and your comments about that verse. You may enter any comment
you want (up to 65536 characters) and select the OK button. This verse
will then be marked with an asterisk (*) to show that a comment exists.
Any time you are reading this verse again, you can display your
comments also. Press ESCAPE or select the Cancel button to leave the
Personal Commentary without saving your comments.

PRINT Button
When you select the Print button, you may choose to print either the
VErse Or your commentary.

UP Button
When you select the UP button, the verse previous in the Bible text will
be displayed with its commentary.

DOWN Button
When you select the DOWN button, the verse following in the Bible text
will be displayed with its commentary.
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GOTO Button
When you select the GOTO button, you may specify any verse in the
Bible you want to be displayed with its commentary.

PRIOR Button
When you select the PRIOR button, the commentary previous in the
Bible text will be displayed with the verse it is associated with.

NEXT Button
When you select the NEXT button, the commentary next in the Bible
text will be displayed with the verse it is associated with.

Using the Clipboard while Editing your Commentary
As you are entering your commentary, you can highlight any portion of
the commentary or Bible text using:

Keyboard: hold Shift while pressing the arrow keys.

Mouse: drag the mouse over the text to be highlighted.

To copy the highlighted text to the clipboard: press Ctrl+INSERT.
To paste the clipboard into your comments:  press Shift+INSERT.
To delete the highlighted text: press the Delete key.

To include the Bible text in your Comments
1. highlight the Bible text you want.
2 copy the highlighted text to the clipboard.
3. position the cursor in your comments.
4. paste the clipboard contents into your comments.

To Delete a Comment
1. highlight all or any part of the comment you want to be deleted.
2. press the Delete key.
3. select the OK button.

Initializing a new Commentary File

If you select the Personal Commentary command and the Personal
Commentary file is not available, you will be asked if you want one
created. If you say Yes, the file will be initialized and ready for your
comments to be entered. If you say No, the Personal Commentary
command will be canceled. If you have previously created a
commentary file, but that file was not found, you may select the System
Control Menu and choose the Settings command. Select the File button
and specify the path where your commentary file can be found.
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Appendix F
Using the Chain Reference Product

This section is included for users who have the Chain Reference product
installed.

Product Description

The best source for understanding the Bible is the Bible itself.
Commentaries show what other people have to say about interpreting
each verse. A chain reference uses the Bible to explain the Bible. Each
verse is chained to other “verses that explain, expand upon, give an
example or an opposite, or deal with a similar thought. By tracing one
thought through the scriptures, you will see beyond the single verse to a
common thread of thought throughout the Bible.

Installing Chain Reference

1. Insert the CHAIN REFERENCE disk in drive A.
2. Type the command: A:INSTALL

3. Set the "Copy From" and "Copy To"

4. The files will be copied to your hard disk.

Note: Each Bible translation has a separate set of Chain Reference files.

Displaying Chain References
Select the StudyAids menu and choose the Chain Reference command.
The Chain Reference command provides a list of other verses that help
in understanding the verse you are currently studying. The screen is
divided into three window:

1. a verse is displayed in the top window,

2. a list of other verses that are related to this verse is displayed at the

right,
3. the text of one of the related verses may be displayed at the bottom.,

The verse displayed in the top window has a highlighted word. When
this window is active, you can use the cursor keys or the mouse to
highlight other words. The references in the Chain window that are tied
to the highlighted word will be marked with an arrow.

The Chain window shows other verses that may help you better
understand the verse displayed. You can use the cursor keys or the
mouse to highlight any reference in the list. The word in the Verse
window that is tied to the reference will be highlighted.
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TEXT Button
If you select the Text button, the reference highlighted in the Chain
window will be displayed in the Related Verse window.

PRINT Button
If you select the Print button, you may choose to print either the Chain
reference list or the text of the related verse.

DOWN Button
The Down button causes the next verse down in the text to be displayed
in the Related Verse window.

UP Button
The Up button causes the previous verse up in the text to be displayed in
the Related Verse window.

GOTO Button
The Goto button causes any verse you specify to be displayed in the
Related Verse window.

NEXT Button

The Next button follows down a chain of thought. The verse currently
shown in the Related Verse window will be moved to the top window
and its chain will be displayed. The Level will show you have moved
one layer deeper in the chain of thought.

PRIOR Button

The Prior button is the opposite of the Next button. It backs up through a
chain of thought. The verse currently shown will be replaced by the
verse at the next higher level in the chain. The Level will show you have
moved one layer higher in the chain of thought. This command allows
you to go back through the chain of verses you just established using the
Next button.

TOP Button

The Top button restores the verse you originally began studying when
you started your chain of thought. The Level will be set to zero, ready
for you to pursue other chains of thought about this verse.
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INSERT Button

The Insert button causes the verse shown in the Related Verse window to
be added to the chain of the verse shown in the top window. The new
verse will be tied to the word that is highlighted in the verse. Any
changes you make to the chain will be saved on the disk when you select
the Ok button or another chain reference list is displayed.

DELETE Butten

The Delete button deletes the highlighted verse from the chain. Any
changes you make to the chain will be saved on the disk when you select
the Ok button or another chain reference list is displayed.

OK Button

The Ok button saves any changes you have made to the chain and closes
the window.

CANCEL Button
The Cancel button closes the window. Changes will not be saved.

Example:

Step 1: Display Genesis 1:1 and choose the Chain Reference command
from the StudyAids menu. The top window shows the word "the”
highlighted. In the Chain window are several references that are all
chained to words within Genesis 1:1. The references that are chained to
the highlighted word are marked with an arrow.

Step 2: Highlight the reference JOH 1:1 in the Chain window. Press the
ENTER key. John 1:1 will be displayed in the Related Verse window.

Step 3: Highlight the reference HEB 1:10 in the Chain window and
press the ENTER key. Hebrew 1:10 will be displayed in the Related
Verse window.

Step 4: Highlight the reference JOB 38:4 in the Chain window. Notice
the word "God" in Genesis 1:1 is now highlighted and the arrows in the
Chain window have changed to show all the references that are chained
to that word. Press the ENTER key. Job 38:4 will be displayed in the
Related Verse window.

Step 5: Select the DOWN button to display Job 38:5 in the Related
Verse window. Select the INSERT button. The reference of Job 38:5 has
been inserted into the Chain window just below the highlighted
reference. It is now chained to the highlighted word in the top window.

Step 6: Select the CANCEL button to leave the Chain Reference without
saving the changes.
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Appendix G
Using the Chronological Bible Product

This section is included for users who have installed the
CHRONOLOGICAL BIBLE product.

Product Description

Placing the Bible text on a computer adds flexibility to your study. For
example, the verses are normally ordered by the book, chapter and verse
sequence with which you are familiar in a printed Bible. But order is
arbitrary in a computer. The text could just as easily be meaningfully
ordered by various other criteria such as by topic or by author. The
Chronological Bible sequences the text of the Bible chronologically.
From creation to the revelation, the verses are presented in the time
sequence to which they best apply.

Some portions of the Bible are easily assigned to a specific time period.
Some portions have only a relative time association. Some portions have
no known criteria for being assigned to any time period. The Old
Testament books of history and the New Testament gospels are examples
of specific time sequencing. The books of wisdom and law and psalms
are more arbitrary. Every attempt has been made to assign each portion
of the Bible to the time period to which they best apply. Because there
may be other views, the outline can be modified as you study the Bible
chronologically.

Installing CHRONOLOGICAL BIBLE

1. Insert the CHRONOLOGICAL BIBLE disk in drive A.
2. Type the command: A:INSTALL

3. Set the "Copy From" and "Copy To"

4. The files will be copied to your hard disk.

Displaying a Chronological Qutline

The Chronological Bible command on the StudyAids menu displays the
primary sections of a chronological outline of the Bible. You may
choose any section and select the Outline button to display an outline of
the Bible sequenced in chronological order. Verses that deal with the
same event are listed together. This provides a view of the Bible from
the perspective of time. The sequencing of events helps in
understanding the unfolding of God's truth from the beginning to the end
of scriptures. You can edit this outline in any way you choose to change
the order of events or to add more details.
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Z. Preparing for Christ's death
Z.1 Heading for Jerusalem

Z.1.1 Final departure from Galilee Mat 19:1-2
Mar 10:1
Luk 9:51-62
Z.1.2 The mission of the seventy Luk 10:1-24
Z.1.3 The good Samaritan Luk 10:25-37
Z.1.4 From Galilee to Judea
Z.1.4.1 Visit Mary and Martha Luk 10:38-42
Z.1.4.2 Jesus teaches on prayer Luk 11:1-13
Z.2 The final journey
Z.2.1 The ten lepers healed Luk 17:11-19
TEXT Button

To review the Bible text related to each event, position the cursor on the
line you want and select the Text button. The verses marked for that
event will be displayed in the scripture window.

PRINT Button
To print this section of the outline, select the Print button.

SECTIONS Button
To display a different section of the chronological outline, select the
SECTIONS button.

OK Button
When you select the OK button, any changes you have made to the
outline will be saved on the disk and the window will be closed.

CANCEL Button
If you change your mind, select the CANCEL button. Any changes you
have made to the outline will not be saved when the window closes.

Sources
The foliowing sources are recommended reading:
A Synoptic Harm f Samuel. Kings an nicles, James Newsome

The Narrated Bible by F. Lagard Smith

The Horizontal Line Synopsis of the Gospels by Reuben J. Swanson
A Harmony of the Gospels by Stevens & Burton

Studies in the Book of Acts by J. Williams
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Appendix H
Using Hebrew/Greek transliterator Products

This section is included for users who have installed the GREEK or the
HEBREW transliterator products.

Product Description

The purpose of the transliterator products is to allow you to associate an
English word with its Greek/Hebrew origins. When THE WORD
processor is displaying text, you may select the StudyAids menu and
choose the Greek/Hebrew Dictionary command. The verse at the top of
the screen will be displayed with Strongs Reference Numbers assigned to
the English words and a Greek/Hebrew Dictionary.

Installing the Greek or the Hebrew transliterator
1. Insert the Transliterator disk in drive A.

2. Type the command: A:INSTALL

3. Set the "Copy From" and "Copy To"

4. The files will be copied to your hard disk.

Strongs Numbering System

The GREEK transliterator includes the Strongs Reference Numbers
associated with the English words of the New Testament Bible text and a
Greek dictionary. The HEBREW transliterator includes the Strongs
Reference Numbers associated with the English words of the Old
Testament Bible text and a Hebrew dictionary. This numbering system
was first published by James R. Strong in 1898 in a book called Strong's
Exhaustive Concordance. Strong's numbering system has become a
standard tool for scripture word study. Strong created a list of every
unique word in the original Greek/Hebrew text, sorted the list in order
and numbered the words. He then assigned one of these numbers to each
word in the Bible except for:

. words that have no direct tie to specific Greek/Hebrew words
(but may be implied by the context)
. articles, etc., of minor significance

To create the disks for the transliterators, Bible Research Systems used a
computer to sort the English text of the King James Bible in alphabetical
order. The computer's list of words was then compared to Strong's
Exhaustive Concordance. The numuer assigned by Strong was then
entered into the computer for each word. The word list was then sorted
back to the original order by book, chapter and verse. Every effort was
made to be consistent with Strong's work. Only the most obvious
printing errors were changed.
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Strong's Greek dictionary and numbering system are based upon the
Greek text from which the King James Version (KJV) was translated.
The New International Version (NIV) text was translated from a different
Greek text. However, we have chosen to remain with Strong's
numbering system applied to the NIV text because Strong's numbers are
the acceptable standard for scripture study tools. This provides a word
origin study tool for the NIV comparable to those available for the KJV.
All examples in the transliterator documentation have been based upon
the King James Version Bible text.

H.1 Find Strongs Numbers command

The Find Strongs Numbers command on the StudyAids menu searches
the Bible for any number- assigned by Strong's Concordance to the
English words. This allows you to find all verses that contain a specified
Greek or Hebrew word in the original text. You may enter any list of
numbers you want to find. Each number represents a Greek/Hebrew
word root.

ADD Button
Each time you enter a number and press ENTER (or select the Add
button) the number you entered will be added to the list.

DELETE Button
Select the Delete button to delete the highlighted number from the list.

EMPTY Button
Select the Empty button to delete all the numbers from the list.

RANGE Button
Select the Range button to set the range of verses to be searched. The
Range must be entirely within the Old Testament or entirely within the
New Testament.

ANY or ALL

If you enter more than one number, you may specify that All the
numbers must be found in the same verse or you may specify that you
want any verse that contains Any of the numbers.

SEARCH Button

Select the Search button to begin the search. All verses within the Range
you specified that contain the numbers you specified will be shown in
the Verse List window.

CANCEL Button
Select the Cancel button if you change your mind and do not want to
search.
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H.2 Show Strongs Numbers command

The Show Strongs Numbers command displays the numbers assigned by
Strong's Concordance to the English words. These numbers can then be
used to display a dictionary entry for the original Greek or Hebrew root
word.

H.3 Greek/Hebrew Dictionary command

The Greek/Hebrew Dictionary command displays a list of all numbers
assigned by Strong's concordance to the verse displayed. The dictionary
entry for the first Greek/Hebrew word will be displayed. You may select
any word in the Bible verse by highlighting the number and pressing the
ENTER key (or double clicking the mouse on the number) and the
dictionary definition will be displayed. You may modify the dictionary
entry at any time and select the Ok button to save your changes. Press
ESCAPE or select the Cancel button to leave the transliterator without
saving your changes.

DICTIONARY Button

The GREEK transliterator includes a Greek dictionary entry for each
Greek word numbered by Strong. The HEBREW transliterator includes
a Hebrew dictionary entry for each Hebrew word numbered by Strong.
The dictionary disks will be used extensively by the transliterators as
you study different verses. The Dictionary button displays an entry from
the dictionary for the Strong's reference number highlighted. Each entry
includes:

- the Greek/Hebrew transliteration (in English syllable form)
- the relation of this word with other Greek/Hebrew words
- the definition of the Greek/Hebrew word

For example, the Greek dictionary entry for #1080 (from which the
English word BORN frequently comes) is displayed as follows:

Strongs Reference Number: 1080
Derivation: Variation of 1085
Transliteration and Definition:
gennao; to procreate

PRINT Button
When you select the Print button, the dictionary entry for the Strongs
number will be printed.




UP Button

When you select the UP button, the verse previous in the Bible text will
be displayed with its dictionary entry.

DOWN Button
When you select the DOWN button, the verse following in the Bible text
will be displayed with its dictionary entry.

GOTO Button
When you select the GOTO button, you may specify any verse in the
Bible you want to be displayed with its dictionary entry.

TRACE List

When a dictionary entry is displayed for any Greek/Hebrew word,
relationships with other Greek/Hebrew words may be shown. You can
trace these word relationships to better understand the meaning of the
Greek/Hebrew words. Each time you select a word from the verse, the
number will be entered in the TRACE list. If the dictionary entry shows
this word is related to other Greek/Hebrew words, their numbers will
also be added to the TRACE list. You may select any number from the
TRACE list by:

1. using the cursor keys to highlight any number, or
2. clicking the mouse on the number you want.

When you select the Dictionary button (or double click on the number in
the TRACE list) the dictionary entry for that number will be displayed.
If that word is also related to other Greek/Hebrew words, their numbers
will be added to the TRACE list and you may select any of them to see
their definitions, This allows you to trace through a family of related
words until you discover a root word from which the others were formed.
For example, if #1085 is highlighted when you select the Dictionary
button, the window will display:

Strongs Reference Number: 1085
Derivation: Derived from 1096
Transliteration and Definition:
genos; kin

The #1096 will be added to the Trace line and highlighted. If you select
the #1096 number, the screen will display:

Strong's Reference Number: 1096
Derivation: A Primary Word
Transliteration and Definition:
genomai; to cause to be

You have just traced the word #1080 to its Greek origin.
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Changing the Dictionary

The dictionary entries have been excerpted from Strong's Exhaustive
Concordance. You may choose to expand or modify the definitions. At
any time a definition is displayed, you may enter your modifications.
When the definition is changed to the way you like, select the OK button
to write the new definition to the disk. Each time that word appears in
the Bible, your new definition will be shown from the dictionary.

H.4 Word Origins Command

Some words in both English and Greek/Hebrew are common and are
always translated in the same way. For other words, the equivalence
across languages is not that precise and variations in translation are
valid. The transliterators include the option to generate a frequency
analysis of word usage. A word origin study within the range of
scripture you select can be requested two ways. You can find all
occurrences of an English word or phrase and count the Greek/Hebrew
origins from which this English was translated. You can find all
occurrences of a Greek/Hebrew word and count the various English
words it was translated to.

To find the various Greek/Hebrew origins of an English word:
1. Use the Find Anything command to search for the verses that
contain the word you want within the range of scripture you want,
2. Choose the Word Origins command from the StudyAids menu.
Every English word that was found will be shown with a list of every
different Greek/Hebrew numbers assigned to that English word.

To find the various English translation of a Greek/Hebrew word:

1. Use the Find Strongs Numbers command to search for the verses
that contain the Strongs Numbers you want within the range of
scripture you want,

2. Choose the Word Origins command from the StudyAids menu.

Every number that was found will be shown with a list of every different
English translation assigned to that number.

The Word Origins list shows how many times each Greek/Hebrew word
was translated to different English text.

PRINT Button
Select the Print button to print the Word Origin analysis.

DICTIONARY Button
Select the Dictionary button to display the Dictionary entry for the
highlighted Strongs number.
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For example, if you searched the KJV New Testament for the word
PRAY, the result will appear on the screen as:

Number Frequency Translation
4336 0042

pray
2065 0010 pray
1189 0007 pray
3870 0004 pray
0000 0003 pray
2172 0002 pray

Total 68

The number indicates the Strongs reference number that identifies which
Greek word occurred in the original text. The frequency indicates how
many times the English search criteria originated from that Greek word.
The frequency of the number 0000 shows how many times the English
search criteria was found with no Strong's number assigned.

You may use the cursor keys (or the mouse) to position the cursor on any
line in the report and request the dictionary entry for that number. The
DICTIONARY button displays the various meanings of the
Greek/Hebrew words that were all translated to the same English word.
For example, the dictionary entry for the numbers in the example above
would show:

#4336 means to pray to God
#2065 means to interrogate
#1189 means to beg

#3870 means to call near
#2172 means to wish

For another example, search Matthew (KJV) for number 1080. Then
choose the Word Origins command from the StudyAids menu. For each
occurrence of the requested Greek/Hebrew number, the various English
translations will be displayed with a count of how frequently they occur.
The result will appear as:

Number Frequency Translation
1080 0039 begat

1080 0005 bom

1080 0001 conceived
Total 45

This means the Greek word numbered 1080 occurred 45 times within
this range. Thirty-nine of those were translated as BEGAT. Only once
was the word CONCEIVED used to convey the original Greek meaning.

Verse Lists based on Greek/Hebrew Origin
If you have the Librarian product and the transliterator installed, you can
build a Verse List based on either the English or the Greek/Hebrew root.
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Appendix I
Using the Bible Dictionary Product

This section is included for users who have the Bible Dictionary product
installed.

PRODUCT DESCRIPTION

A dictionary defines words and their meanings. A Bible Dictionary
defines the special meanings given to words when used in scripture.
Common words are not included because their meaning is the same in
scripture as when used elsewhere. A Bible Dictionary gives historical
background and Biblical usage that helps you understand the language
used in scripture.

Installing Bible Dictionary

1. Insert the Bible Dictionary disk in drive A.
2. Type the command: A:INSTALL

3. Set the "Copy From" and "Copy To"

4. The files will be copied to your hard disk.

Displaying Bible Dictionary

Select the StudyAids menu and choose the Bible Dictionary command.
The Bible Dictionary command allows you to display and modify a
definition for any word in the Bible. Bible Dictionary displays a list of
every unique word in the Bible. To select any word:

1. use the cursor keys to highlight the word you want, or
2. click the mouse on the word you want,
3. type the letters of the word until the word you want is shown.

DICTIONARY Button

When the word you want is highlighted, select the Dictionary button (or
double click on the word). If the word you highlighted has been defined
in the dictionary, the definition of the word will be displayed. You may
return to the word list and select another word at any time. You may
enter any additions you want and select the OK button. Your changes
will be saved as a permanent definition of that word.

CANCEL Button
Press ESCAPE or select the Cancel button to leave the Dictionary
without saving your changes.

PRINT Button
When you select the Print button, the word and its definition will be
printed.
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Glossary

Active
Describes a window that is selected. It is this window to which the next
keystroke or command will apply.

Check box

A check box is represented by square brackets ([ ]) with a single space
between them. Check boxes are usually used to denote an option that
may be selected. If the letter X appears between the brackets, as in "[X]"
the option has been selected.

Click
To press and release a mouse button quickly.

Clipboard
A temporary storage area for holding information that you are moving or
copying.

Command
A word or phrase, usually found in a menu, that you choose in order to
carry out an action.

Command button

A large rectangle that appears in a dialog box that carries out or cancels
an action when chosen. The Cancel button always cancels the command.
The Ok button carries out the command. Occasionally, the button that
carries out the command will have a label that describes the action.

Control menu
The control menu is used to control the size and placement of the
window on the screen. It may also be used to close the window.

Control Menu Box

Windows which allow their size and placement to be controlled have a
Control Menu Box in the upper left corner of the window border. If you
have a mouse you can click on the Control Menu Box to access the
control menu.

Copy
To place a copy of your selected text in the clipboard.

Default

Describes an option, command or device that is automatically selected or
chosen by the system. For example, dialog boxes contain a command
button which is selected when the dialog box appears, indicating that it is
the default and will be chosen automatically if you press ENTER. You
can override a default by selecting another option, command or device.
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Dialog box

A box that appears in the middle of the screen when the system needs
further information to carry out a command or when the system is
providing you with certain information.

Directory
A list of files in a particular group on your disk.

Double-click
To rapidly press and release a mouse button twice. This action carries out
the command where the mouse pointer is setting.

Drag
To press the mouse button and hold it down while moving the mouse.

Extension
The period and three letters at the end of a filename.

Filename
The name of a file. Filenames consist of a base name containing no more
than eight characters and an optional three-character extension.

Grayed

Describes a command or option that is listed in a menu or dialog box that
cannot be chosen or selected. The command or option appears in lower
intensity. For example, when the clipboard is empty, the Paste command
is grayed.

Highlighted
Indicates that the item is selected and will be affected by your next
action. A highlighted item appears in reverse video.

Inactive
Describes a window that is open but not selected.

Insertion point
The place that text will be inserted when you type. The insertion point
usually appears as a flashing horizontal line or flashing character.

List box
A box within a dialog box that lists all items that a command could
affect. For example, the names of all files in a given directory.

Maximize box

The symbol "»" that appears in the upper right corner of the window
border. If you have a mouse, you may click on the maximize box in
order to expand the window to its maximum limits.
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Menu

A group of available commands. Menu names appear in the menu bar at
the top of the screen. You use a command from a menu by selecting the
menu, then choosing the command.

Menu bar
The horizontal bar at the top of the screen that lists the menus.

Option button

A button denoted by parenthesis "( )" separated by a single character.
Option buttons appear in dialog boxes. A dot appears between the
parenthesis when the option is selected. Within a group of related option
buttons, you can make only one selection.

Paste
To transfer the contents of the clipboard to a window.

Pathname
A description of the location of a directory or file within the system. For
example, the pathname of a file consists of a drive letter, followed by a
directory name, one or more subdirectory names if applicable, and a file
name. Each name is separated from the previous one by a backslash
character.

Point
To move the mouse pointer until it rests on the item you want to select.

Pointer

A small rectangular symbol that appears if you have installed a mouse.
The pointer indicates the area of the screen that will be affected if you
click a mouse button. The pointer reverses the video characteristics of
the character it covers, while leaving the character "under it" visible.

Restore box

A symbol "«" that appears to the immediate left of the maximize box in
the upper right corner of a window's border. If you have a mouse you
may click in the restore box to restore a maximized window to its size
prior to the maximize operation.

Save
To write information to a file on disk.

Scroll
To move text up or down or left or right to see parts of a large body of
information that cannot fit on the screen at one time.



Scroll bar

A bar that appears at the right and/or bottom of some windows and in
some dialog boxes. The scroll bar contains a scroll arrow at either end
and a scroll box that moves within the scroll bar, reflecting your position
in the data. Mouse users can click part of the scroll bar to scroll a file.

Select
To indicate the item that the next command you choose will affect.

Shortcut key
A special key or key chord that you can press to execute a command
without first selecting a menu.

System Control Menu
A menu of commands used to customize for your hardware.

Text box

A box in a dialog box in which you type information needed to carry out
a command. The text box may be blank when the dialog box appears or
may contain text if there is a default option or you have selected
something applicable to this command. Sometimes, a text box appears
not as a rectangle, but as square brackets which frame the area into which
text is to be entered. For example: "[........]".

Title bar
The horizontal bar across the top of each window that contains the name
of the information displayed in the window.

Wildcard character

When searching for a file, an asterisk (*) can be included in the filename
to indicate that any set of characters would be accepted as a match. For
example, *.TXT represents all files in the directory that end with the
.TXT extension.

Window
A bordered area on your screen where information is displayed and work
is performed.
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Index
active window, 35,50
ADD Button, 27,91
ALIGN Button, 17
ASCii text file, 31,32
asterisk (*), 83
Auto Line Feed, 21
Bible Dictionary command, 96
Book Name Abbreviations, 7
BookMark, 14
Bottom Margin, 20
CANCEL Button, 87,89,91,96
CGA Color Adaptor Card, 3,60
Chain Reference, 85
Chain Reference command, 85
Change command, 76
Checkmark, 39
choosing a command, 38,40,41,42
Chronological Bible, 88
Chronological Bible command, 88
Clear command, 75
Clipboard, 54,84
Close command, 14,58,74
COLOR
Background Option, 63
Foreground Option, 63
Expanded Colors, 61
palettes, 61
Combination, 72
Control menu, 35, 56
Copy command, 75
Copy Range command, 75
Copy Verse command, 75
Copy Verse List command, 75
Customizing, 59
Cut command, 75
Delay Factor, 69
DELETE Button, 25,27,87,91
Description command, 72
Desktop, 33,34
Dialog box, 43
DICTIONARY Button, 92,94,96
Double-click, 6,59
DOWN Button, 83,86,93
Drag, 6
Edit menu, 75
Editing commands, 53
EMPTY Button, 27,91
Empty Verse List command, 72
Expanded Colors, 61
Exit command, 3
FILE Button, 19
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File menu, 73
Files
Autosave, 60
File Name, 51,52,73
Opening, 51
Paths, 61
Find a Word command, 23
Find Anything command, 26,29
Find command, 76
Find Next command, 24,76
Find Previous command, 24
Find Strongs Numbers command, 91
FORM Button, 17
Full BCV Reference, 20
Glossary, 97
Go To A Verse command, 13
Go To BookMark command, 14
Go to Last Verse Shown command, 13
GOTO Button, 84,86,93
grayed commands, 39
Greek transliterator, 90
Greek/Hebrew Dictionary command, 92
Hebrew transliterator, 90
Help menu, 4
HOME key, 11,12
hotkey, 64,70
INSERT Button, 25,87
INSERT key, 52,84
insert mode, 52
Installation, 2
Bible Dictionary, 96
Chain Reference, 85
Chronological Bible, 88
Greek transliterator, 90
Hebrew transliterator, 90
Librarian, 71
People, 80
Personal Commentary, 83
Topics, 77
Verse Search, 2
Verse Typist, 64
Instant Access, 30
Intersection, 72
King James Command, 15
Left Margin, 20
Lesson Editor command, 73
Librarian, 71
LINE Button, 17
List Box, 46
Load a Verse List command, 71
Load command, 73
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Maximize command, 35,56
Menu, 33,38
Menu Bar, 33,40,73
Merge a Verse List command, 72
Merge command, 74
MORE Button, 23
Mouse
Acceleration Option, 60
Double-click Option, 59
Swap Buttons Option, 60
Move command, 57
New International Command, 15
New King James Command, 15
Next Book command, 13
NEXT Button, 84,86
Next Chapter command, 13
NIV Footnote command, 15
OK Button, 87,89
Open Scriptures command, 14
overwrite mode, 52
Page Feed, 21
Page Layout command, 20
Page Length, 20
PALETTES Button, 62
Paste command, 75
PEOPLE, 80
Personal Commentary command, 83
plus sign (+), 5
Previous Book command, 13
Previous Chapter command, 13
PRINT Button, 83,86,89,92,94,96
Print command, 74
Printer
Highlight, 22
Initialization, 22
Setup, 21
Printing
Cancel Printing, 19
One Verse, 18
Range of Verses, 18
Verse List, 18
PRIOR Button, 84,86
PROXIMITY, 28
Quit menu, 3
RANGE Button, 27,91
Remove a Verse List command, 72
Restore command, 35,56
Revised Standard Command, 15
Right Margin, 20
Save a Verse List command, 71
Save command, 74
Scroll Bar, 36,37,45
Scroll Position Indicator, 37
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Search

for ALL values, 27

for ANY values, 27

for Strongs Numbers, 91
SEARCH Button, 27,91
Search menu, 13,76
Searching

for a Concept, 29

for a List of Wonrds, 29

for a Phrase, 29

for a Prefix, 29

for a Word, 23

Only a Specified Range, 30
SECTIONS Button, 89
selecting a menu, 38,40,41,42
Selecting Text, 55
Set a BookMark command, 14
Settings command, 59
Setup Button, 21
shortcut keys, 12,39,41,50,53,54
Show List command, 25
Show Strongs Numbers command, 92
Side by Side command, 14
Size command, 36,58
Sort Verse List command, 72
Sound

Duration Option, 60

Mute Option, 60

Pitch Option, 60
Spacing, 20
Status Line, 33,34
Strongs Numbering System, 90
Synchronize command, 15
synonyms, 26
System Control menu, 21,59
Test Ready Status, 21
TEXT Button, 86,89
Text Editing Commands, 53
THESAURUS, 26
TOP Button, 86
Top Margin, 20
TOPICS, 77
TRACE, 93
Transfer command, 64
Translation menu, 15,16
transliterator, 90
UP Button, 83,86,93
VERSE TYPIST, 64
What to Do Now command, 4
Window, 34,35
WINDOW Button, 61
Windows menu, 50, 51
Word Origins command, 94,95










RESEARCH
SYSTEMS

2013 Wells Branch Parkway
| Suite 304

Austin, Texas 78728

(512) 251-7541




